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1

API docs

1.1 check50
check50.import_checks(path)
Import checks module given relative path.
Parameters path (str) – relative path from which to import checks module
Returns the imported module
Raises
• FileNotFoundError – if path / .check50.yaml does not exist
• yaml.YAMLError – if path / .check50.yaml is not a valid YAML file
This function is particularly useful when a set of checks logically extends another, as is often the case in CS50’s
own problems that have a “less comfy” and “more comfy” version. The “more comfy” version can include all
of the “less comfy” checks like so:
less = check50.import_checks("../less")
from less import *

Note: the __name__ of the imported module is given by the basename of the specified path (less in the
above example).
check50.data(**kwargs)
Add data to the check payload
Params kwargs key/value mappings to be added to the check payload
Example usage:
check50.data(time=7.3, mem=23)
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check50.exists(*paths)
Assert that all given paths exist.
Params paths files/directories to be checked for existence
Raises check50.Failure – if any path in paths does not exist
Example usage:
check50.exists("foo.c", "foo.h")

check50.hash(file)
Hashes file using SHA-256.
Parameters file (str) – name of file to be hashed
Return type str
Raises check50.Failure – if file does not exist
check50.include(*paths)
Copy files/directories from the check directory (check50.internal.check_dir), to the current directory
Params paths files/directories to be copied
Example usage:
check50.include("foo.txt", "bar.txt")
assert os.path.exists("foo.txt") and os.path.exists("bar.txt")

class check50.run(command, env={})
Run a command.
Parameters
• command (str) – command to be run
• env (dict) – environment in which to run command
By default, the command will be run using the same environment as check50, these mappings may be overriden via the env parameter:
check50.run("./foo").stdin("foo").stdout("bar").exit(0)
check50.run("./foo", env={ "HOME": "/" }).stdin("foo").stdout("bar").exit(0)

exit(code=None, timeout=5)
Wait for process to exit or until timeout (5 sec by default) and asserts that process exits with code. If
code is None, returns the code the process exited with.
..note:: In order to ensure that spawned child processes do not outlive the check that spawned them, it is
good practice to call either method (with no arguments if the exit code doesn’t matter) or .kill() on
every spawned process.
Parameters
• code (int) – code to assert process exits with
• timeout (int / float) – maximum number of seconds to wait for the program to
end
Raises check50.Failure – if code is given and does not match the actual exitcode within
timeout
Example usage:
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check50.run("./hello").exit(0)
code = check50.run("./hello").exit()
if code != 0:
raise check50.Failure(f"expected exit code 0, not {code}")

kill()
Kill the process.
Child will first be sent a SIGHUP, followed by a SIGINT and finally a SIGKILL if it ignores the first
two.
reject(timeout=1)
Check that the process survives for timeout. Useful for checking whether program is waiting on input.
Parameters timeout (int / float) – number of seconds to wait
Raises check50.Failure – if process ends before timeout
stdin(line, prompt=True, timeout=3)
Send line to stdin, optionally expect a prompt.
Parameters
• line (str) – line to be send to stdin
• prompt (bool) – boolean indicating whether a prompt is expected, if True absorbs all of
stdout before inserting line into stdin and raises check50.Failure if stdout is empty
• timeout (int / float) – maximum number of seconds to wait for prompt
Raises check50.Failure – if prompt is set to True and no prompt is given
stdout(output=None, str_output=None, regex=True, timeout=3)
Retrieve all output from stdout until timeout (3 sec by default). If output is None, stdout returns all
of the stdout outputted by the process, else it returns self.
Parameters
• output (str) – optional output to be expected from stdout, raises check50.Failure
if no match
• str_output (str) – what will be displayed as expected output, a human readable form
of output
• regex (bool) – flag indicating whether output should be treated as a regex
• timeout (int / float) – maximum number of seconds to wait for output
Raises
• check50.Mismatch – if output is specified and nothing that the process output
matches it
• check50.Failure – if process times out or if it outputs invalid UTF-8 text.
Example usage:
check50.run("./hello").stdout("[Hh]ello, world!?", "hello, world").exit()
output = check50.run("./hello").stdout()
if not re.match("[Hh]ello, world!?", output):
raise check50.Mismatch("hello, world", output)

1.1. check50

3

CS50 Docs Documentation

check50.log(line)
Add to check log
Parameters line (str) – line to be added to the check log
The check log is student-visible via the --log flag to check50.
exception check50.Failure(rationale, help=None)
Exception signifying check failure.
Parameters
• rationale (str) – message to be displayed capturing why the check failed
• help (str) – optional help message to be displayed
Example usage:
out = check50.run("./cash").stdin("4.2").stdout()
if 10 not in out:
help = None
if 11 in out:
help = "did you forget to round your result?"
raise check50.Failure("Expected a different result", help=help)

exception check50.Mismatch(expected, actual, help=None)
Exception signifying check failure due to a mismatch in expected and actual outputs.
Parameters
• expected – the expected value
• actual – the actual value
• help (str) – optional help message to be displayed
Example usage:
from re import match
expected = "[Hh]ello, world!?\n"
actual = check50.run("./hello").stdout()
if not match(expected, actual):
help = None
if match(expected[:-1], actual):
help = r"did you forget a newline ('\n') at the end of your printf string?
˓→"
raise check50.Mismatch("hello, world\n", actual, help=help)

check50.check(dependency=None, timeout=60)
Mark function as a check.
Parameters
• dependency (function) – the check that this check depends on
• timeout (int) – maximum number of seconds the check can run
When a check depends on another, the former will only run if the latter passes. Additionally, the dependent
check will inherit the filesystem of its dependency. This is particularly useful when writing e.g., a compiles
check that compiles a student’s program (and checks that it compiled successfully). Any checks that run the
student’s program will logically depend on this check, and since they inherit the resulting filesystem of the
check, they will immidiately have access to the compiled program without needing to recompile.
Example usage:
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@check50.check() # Mark 'exists' as a check
def exists():
"""hello.c exists"""
check50.exists("hello.c")
@check50.check(exists) # Mark 'compiles' as a check that depends on 'exists'
def compiles():
"""hello.c compiles"""
check50.c.compile("hello.c")
@check50.check(compiles)
def prints_hello():
"""prints "Hello, world!\\n"""
# Since 'prints_hello', depends on 'compiles' it inherits the compiled binary
check50.run("./hello").stdout("[Hh]ello, world!?\n", "hello, world\n").exit()

exception check50.EOF(value)
Raised when EOF is read from a child. This usually means the child has exited.

1.2 check50.c
check50.c.CC = 'clang'
Default compiler for check50.c.compile()
check50.c.CFLAGS = {'ggdb': True, 'lm':
Default CFLAGS for check50.c.compile()

True, 'std':

'c11'}

check50.c.compile(*files, exe_name=None, cc=’clang’, **cflags)
Compile C source files.
Parameters
• files – filenames to be compiled
• exe_name – name of resulting executable
• cc – compiler to use (check50.c.CC by default)
• cflags – additional flags to pass to the compiler
Raises
• check50.Failure – if compilation failed (i.e., if the compiler returns a non-zero exit
status).
• RuntimeError – if no filenames are specified
If exe_name is None, check50.c.compile() will default to the first file specified sans the .c extension:
check50.c.compile("foo.c", "bar.c") # clang foo.c bar.c -o foo -std=c11 -ggdb -lm

Additional CFLAGS may be passed as keyword arguments like so:
check50.c.compile("foo.c", "bar.c", lcs50=True) # clang foo.c bar.c -o foo ˓→std=c11 -ggdb -lm -lcs50

In the same vein, the default CFLAGS may be overriden via keyword arguments:

1.2. check50.c
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check50.c.compile("foo.c", "bar.c", std="c99", lm=False) # clang foo.c bar.c -o
˓→foo -std=c99 -ggdb

check50.c.valgrind(command, env={})
Run a command with valgrind. :param command: command to be run :type command: str :param env: environment in which to run command :type env: str :raises check50.Failure: if, at the end of the check, valgrind
reports any errors
This function works exactly like check50.run(), with the additional effect that command is run through
valgrind and valgrind’s output is automatically reviewed at the end of the check for memory leaks and
other bugs. If valgrind reports any issues, the check is failed and student-friendly messages are printed to
the log.
Example usage:
check50.c.valgrind("./leaky").stdin("foo").stdout("bar").exit(0)

Note: It is recommended that the student’s code is compiled with the -ggdb flag so that additional information,
such as the file and line number at which the issue was detected can be included in the log as well.

1.3 check50.flask
class check50.flask.app(path, app_name=’app’)
Spawn a Flask app.
Parameters
• path (str) – path to python file containing Flask app
• app_name – name of Flask app in file
Example usage:
check50.flask.app("application.py").get("/").status(200)

content(output=None, str_output=None, **kwargs)
Searches for output regex within HTML page. kwargs are passed to BeautifulSoup’s find function to filter
for tags.
get(route, data=None, params=None, follow_redirects=True)
Send GET request to app.
Parameters
• route (str) – route to send request to
• data (dict) – form data to include in request
• params – URL parameters to include in request
• follow_redirects (bool) – enable redirection (defaults to True)
Returns self
Raises check50.Failure – if Flask application throws an uncaught exception
Example usage:
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check50.flask.app("application.py").get("/buy", params={"q": "02138"}).
˓→content()

post(route, data=None, params=None, follow_redirects=True)
Send POST request to app.
Parameters
• route (str) – route to send request to
• data (dict) – form data to include in request
• params – URL parameters to include in request
• follow_redirects (bool) – enable redirection (defaults to True)
Raises check50.Failure – if Flask application throws an uncaught exception
Example usage:
check50.flask.app("application.py").post("/buy", data={"symbol": "GOOG",
˓→"shares": 10}).status(200)

raw_content(output=None, str_output=None)
Searches for output regex match within content of page, regardless of mimetype.
status(code=None)
Check status code in response returned by application. If code is not None, assert that code is returned
by application, else simply return the status code.
Parameters code (int) – code to assert that application returns
Example usage:
check50.flask.app("application.py").status(200)
status = check50.flask.app("application.py").get("/").status()
if status != 200:
raise check50.Failure(f"expected status code 200, but got {status}")

1.4 check50.py
check50.py.append_code(original, codefile)
Append the contents of one file to another.
Parameters
• original (str) – name of file that will be appended to
• codefile (str) – name of file that will be appende
This function is particularly useful when one wants to replace a function in student code with their own implementation of one. If two functions are defined with the same name in Python, the latter definition is taken so
overwriting a function is as simple as writing it to a file and then appending it to the student’s code.
Example usage:

1.4. check50.py
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# Include a file containing our own implementation of a lookup function.
check50.include("lookup.py")
# Overwrite the lookup function in helpers.py with our own implementation.
check50.py.append_code("helpers.py", "lookup.py")

check50.py.compile(file)
Compile a Python program into byte code :param file: file to be compiled :raises check50.Failure: if compilation
fails e.g. if there is a SyntaxError
check50.py.import_(path)
Import a Python program given a raw file path
Parameters path (str) – path to python file to be imported
Raises check50.Failure – if path doesn’t exist, or if the Python file at path throws an exception when imported.

1.5 check50.internal
Additional check50 internals exposed to extension writers in addition to the standard API
class check50.internal.Register
Class with which functions can be registered to run before / after checks. check50.internal.register
should be the sole instance of this class.
after_check(func)
Run func once at the end of the check, then discard func.
after_every(func)
Run func at the end of every check.
before_every(func)
Run func at the start of every check.
check50.internal.check_dir = None
Directory containing the check and its associated files
check50.internal.import_file(name, path)
Import a file given a raw file path.
Parameters
• name (str) – Name of module to be imported
• path (str / Path) – Path to Python file
check50.internal.load_config(check_dir)
Load configuration file from check_dir / ".cs50.yaml", applying defaults to unspecified values.
Parameters check_dir (str / Path) – directory from which to load config file
Return type dict
check50.internal.register = <check50.internal.Register object>
Sole instance of the check50.internal.Register class
check50.internal.run_dir = None
Temporary directory in which check is being run
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2

Writing check50 checks

check50 checks live in a git repo on Github. check50 finds the git repo based on the slug that is passed to check50.
For instance, consider the following execution of check50:
check50 cs50/problems/2018/x/hello

check50 will look for an owner called cs50, a repo called problems, a branch called 2018 or 2018/x and a problem
called x/hello or hello. The slug is thus parsed like so:
check50 <owner>/<repo>/<branch>/<problem>

2.1 Creating a git repo
To get you started, the first thing you need to do is . Once you have done so, or if you already have an account with
Github, . Make sure to think of a good name for your repo, as this is what students will be typing. Also make sure
your repo is set to public, it is initialised with a README, and finally add a Python .gitignore. Ultimately you should
have something looking like this:
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2.2 Creating a check and running it
Your new repo should live at https://github.com/<user>/<repo>, that is https://github.com/
cs50/example_checks in our example. Once you have created your new repo, create a new file by clicking
the Create new file button:

Then continue by creating the following .cs50.yaml file. All indentation is done by 2 spaces, as per YAML syntax.
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Or in text, if you want to quickly copy-paste:
Listing 1: .cs50.yaml
1
2
3
4
5
6

check50:
checks:
hello world:
- run: python3 hello.py
stdout: Hello, world!
exit: 0

Note that you should create a directory like in the example above by typing: example/.cs50.yaml. Once you have
populated the file with the code above. Scroll down the page and hit the commit button:

That’s it! You know have a repo that check50 can use to check whether a python file called hello.py prints Hello,
world! and exits with a 0 as exit code. To try it, simply execute:
check50 <owner>/<repo>/master/example --local

Where you substitute <owner> for your own username, <repo> for the repo you’ve just created. Given that a file
called hello.py is in your current working directory, and it actually prints Hello, world! when run, you should
now see the following:

2.2. Creating a check and running it
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:) hello world

2.3 Simple YAML checks
To get you started, and to cover the basics of input/output checking, check50 lets you write simple checks in YAML
syntax. Under the hood, check50 compiles these YAML checks to Python checks that check50 then runs.
YAML checks in check50 all live in .cs50.yaml and start with a top-level key called check50, that specifies a
checks. The checks record contains all checks, where the name of the check is the name of the YAML record.
Like so:
Listing 2: .cs50.yaml
1
2
3
4
5
6
7
8

check50:
checks:
hello world: # define a check named hello world
# check code
foo: # define a check named foo
# check code
bar: # define a check named bar
# check code

This code snippet defines three checks, named hello world, foo and bar respectively. These checks should
contain a list of run records, that can each contain a combination of stdin, stdout and exit. See below:
Listing 3: .cs50.yaml
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22

check50:
checks:
hello world:
- run: python3 hello.py # run python3 hello.py
stdout: Hello, world! # expect Hello, world! in stdout
exit: 0 # expect program to exit with exitcode 0
foo:
- run: python3 foo.py # run python3 foo.py
stdin: baz # insert baz into stdin
stdout: baz # expect baz in stdout
exit: 0 # expect program to exit with exitcode 0
bar:
- run: python3 bar.py # run python3 bar.py
stdin: baz # insert baz into stdin
stdout: bar baz # expect bar baz in stdout
- run: python3 bar.py # run python3 bar.py
stdin:
- baz # insert baz into stdin
- qux # insert qux into stdin
stdout:
- bar baz # first expect bar baz in stdout
- bar qux # then expect bar qux in stdout

The code snippet above again defines three checks: hello world, foo and bar.
The hello world check runs python3 hello.py in the terminal, expects Hello, world! to be outputted
in stdout, and then expects the program to exit with exitcode 0.
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The foo check runs python3 foo.py in the terminal, inserts baz into stdin, expects baz to be outputted in stdout,
and finally expects the program to exit with exitcode 0.
The bar check runs two commands in order in the terminal. First python3 bar.py gets run, baz gets put in stdin
and bar baz is expected in stdout. There is no mention of exit here, so the exitcode is not checked. Secondly,
python3 bar.py gets run, baz and qux get put into stdin, and first bar baz is expected in stdout, then bar
qux.
We encourage you to play around with the example above by copying its code to your checks git repo. Then try to
write a bar.py and foo.py that make you pass these tests.
In case you want to check for multiline input, you can make use of YAML’s | operator like so:
Listing 4: .cs50.yaml
1
2
3
4
5
6
7
8

check50:
checks:
multiline hello world:
- run: python3 multi_hello.py
stdout: | # expect Hello\nWorld!\n in stdout
Hello
World!
exit: 0

2.4 Developing locally
To write checks on your own machine, rather than on the Github webpage, you can clone the repo via:
git clone https://github.com/<owner>/<repo>

Where <owner> is your Github username, and <repo> is the name of your checks repository. Head on over to the
new directory that git just created, and open up .cs50.yaml with your favorite editor.
To run the cloned checks locally, check50 comes with a --dev mode. That will let you target a local checks repo,
rather than a github repo. So if your checks live in /Users/cs50/Documents/example_checks, you would
execute check50 like so:
check50 --dev /Users/cs50/Documents/example_checks/example

This runs the example check from /Users/cs50/Documents/example_checks. You can also specify a relative path, so if your current working directory is /Users/cs50/Documents/solutions, you can execute
check50 like so:
check50 --dev ../example_checks/example

Now you’re all set to develop new checks locally. Just remember to git add, git commit and git push when
you’re done writing checks. Quick refresher:
git add .cs50.yaml
git commit -m "wrote some awesome new checks!"
git push

2.4. Developing locally
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2.5 Getting started with Python checks
If you need a little more than strict input / output testing, check50 lets you write checks in Python. A good starting
point is the result of the compilation of the YAML checks. To get these, please make sure you have cloned the repo
(via git clone ), and thus have the checks locally. First we need to run the .YAML checks once, so that check50
compiles the checks to Python. To do this execute:
check50 --dev <checks_dir>/<check>

Where <checks_dir> is the local git repo of your checks, and <check> is the directory in which .cs50.yaml
lives. Alternatively you could navigate to this directory and simply call:
check50 --dev .

As a result you should now find a file called __init__.py in the check directory. This is the result of check50’s
compilation from YAML to Python. For instance, if your .cs50.yaml contains the following:
Listing 5: .cs50.yaml
1
2
3
4
5
6

check50:
checks:
hello world:
- run: python3 hello.py
stdout: Hello, world!
exit: 0

You should now find the following __init__.py:
Listing 6: __init__.py
1

import check50

2
3
4
5
6

@check50.check()
def hello_world():
"""hello world"""
check50.run("python3 hello.py").stdout("Hello, world!", regex=False).exit(0)

check50 will by default ignore and overwrite what is in __init__.py for as long as there are checks in .cs50.
yaml. To change this you have to edit .cs50.yaml to:
Listing 7: .cs50.yaml
check50:
checks: __init__.py

By doing so you are effectively telling check50 to look in __init__.py for checks. If you want, you can rename
__init__.py to anything else, as long as you tell check50 where to look via .cs50.yaml. To test whether
everything is still in working order, run check50 again with:
check50 --dev <checks_dir>/<check>

You should see the same results as the YAML checks gave you. Now that there are no YAML checks in .cs50.yaml
and check50 knows where to look for Python checks, you can start writing Python checks. You can find documentation
in API docs, and examples of Python checks below.

14
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2.6 Python check specification
A Python check is made up as follows:
Listing 8: __init__.py
1

import check50 # import the check50 module

2
3
4
5
6

@check50.check() # tag the function below as check50 check
def exists(): # the name of the check
"""description""" # this is what you will see when running check50
check50.exists("hello.py") # the actual check

7
8
9
10
11

@check50.check(exists) # only run this check if the exists check has passed
def prints_hello():
"""prints "hello, world\\n" """
check50.run("python3 hello.py").stdout("[Hh]ello, world!?\n", regex=True).exit(0)

check50 uses its check decorator to tag functions as checks. You can pass another check as argument to specify a
dependency. Docstrings are used as check descriptions, this is what will ultimately be shown when running check50.
The checks themselves are just Python code. check50 comes with a simple API to run programs, send input to stdin,
and check or retrieve output from stdout. A check fails if a check50.Failure exception or an exception inheriting
from check50.Failure like check50.Mismatch is thrown. This allows you to write your own custom check
code like so:
Listing 9: __init__.py
1

import check50

2
3
4
5
6

@check50.check()
def prints_hello():
"""prints "hello, world\\n" """
from re import match

7

expected = "[Hh]ello, world!?\n"
actual = check50.run("python3 hello.py").stdout()
if not match(expected, actual):
help = None
if match(expected[:-1], actual):
help = r"did you forget a newline ('\n') at the end of your printf string?

8
9
10
11
12
13
˓→
14

"
raise check50.Mismatch("hello, world\n", actual, help=help)

The above check breaks out of check50’s API by calling stdout() on line 9 with no args, effectively retrieving all
output from stdout in a string. Then there is some plain Python code, matching the output through Python’s builtin
regex module re against a regular expression with the expected outcome. If it doesn’t match, a help message is
provided only if there is a newline missing at the end. This help message is provided through an optional argument
help passed to check50’s Mismatch exception.
You can share state between checks if you make them dependent on each other. By default file state is shared, allowing
you to for instance test compilation in one check, and then depend on the result of the compilation in dependent checks.
Listing 10: __init__.py
1
2

import check50
import check50.c

3

(continues on next page)

2.6. Python check specification
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(continued from previous page)
4
5
6
7

@check50.check()
def compiles():
"""hello.c compiles"""
check50.c.compile("hello.c")

8
9
10
11
12

@check50.check(compiles)
def prints_hello():
"""prints "hello, world\\n" """
check50.run("./hello").stdout("[Hh]ello, world!?\n", regex=True).exit(0)

You can also share Python state between checks by returning what you want to share from a check. It’s dependent can
accept this by accepting an additional argument.
Listing 11: __init__.py
1

import check50

2
3
4
5

@check50.check()
def foo():
return 1

6
7
8
9

@check50.check(foo)
def bar(state)
print(state) # prints 1

2.7 Python check examples
Below you will find examples of Python checks. Don’t forget to for more examples. You can try them yourself by
copying them to __init__.py and running:
check50 --dev <checks_dir>/<check>

Check whether a file exists:
Listing 12: __init__.py
1

import check50

2
3
4
5
6

@check50.check()
def exists():
"""hello.py exists"""
check50.exists("hello.py")

Check stdout for an exact string:
Listing 13: __init__.py
1
2
3
4

@check50.check(exists)
def prints_hello_world():
"""prints Hello, world!"""
check50.run("python3 hello.py").stdout("Hello, world!", regex=False).exit(0)

Check stdout for a rough match:

16
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Listing 14: __init__.py
1
2
3
4
5

@check50.check(exists)
def prints_hello():
"""prints "hello, world\\n" """
# regex=True by default :)
check50.run("python3 hello.py").stdout("[Hh]ello, world!?\n").exit(0)

Put something in stdin, expect it in stdout:
Listing 15: __init__.py
1

import check50

2
3
4
5
6

@check50.check()
def id():
"""id.py prints what you give it"""
check50.run("python3 hello.py").stdin("foo").stdout("foo").stdin("bar").stdout(
˓→"bar")

Be helpful, check for common mistakes:
Listing 16: __init__.py
1
2

import check50
import re

3
4
5
6
7

def coins(num):
# regex that matches `num` not surrounded by any other numbers
# (so coins(2) won't match e.g. 123)
return fr"(?<!\d){num}(?!\d)"

8
9
10
11
12
13
14
15
16
17
18

@check50.check()
def test420():
"""input of 4.2 yields output of 18"""
expected = "18\n"
actual = check50.run("python3 cash.py").stdin("4.2").stdout()
if not re.search(coins(18), actual):
help = None
if re.search(coins(22), actual):
help = "did you forget to round your input to the nearest cent?"
raise check50.Mismatch(expected, actual, help=help)

Create your own assertions:

2.7. Python check examples
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Listing 17: __init__.py
1

import check50

2
3
4
5
6
7
8

@check50.check()
def atleast_one_match()
"""matches either foo, bar or baz"""
output = check50.run("python3 qux.py").stdout()
if not any(answer in output for answer in ["foo", "bar", "baz"]):
raise check50.Failure("no match found")

2.8 Configuring check50
Check50, and other CS50 tools like submit50 and lab50, use a special configuration file called .cs50.yaml. Here
is how you can configure check50 via .cs50.yaml.

2.8.1 checks:
checks: takes either a truthy value to indicate that this slug is valid for check50, or a filename specifying a file
containing check50 Python checks, or a record of check50 YAML checks.
Listing 18: .cs50.yaml
1
2

check50:
checks: true

Only specifies that this is a valid slug for check50. This configuration will allow you to run check50 <slug>, by
default check50 will look for an __init__.py containing Python checks.
Listing 19: .cs50.yaml
1
2

check50:
checks: "my_filename.py"

Specifies that this is a valid slug for check50, and has check50 look for my_filename.py instead of __init__.
py.
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Listing 20: .cs50.yaml
1
2
3
4
5
6

check50:
checks:
hello world:
- run: python3 hello.py
stdout: Hello, world!
exit: 0

Specifies that this is a valid slug for check50, and has check50 compile and run the YAML check. For more on YAML
checks in check50 see :ref:check_writer.

2.8.2 files:
files: takes a list of files/patterns. Every item in the list must be tagged by either !include, !exclude or
!require. All files matching a pattern tagged with !include are included and likewise for !exclude. !
require is similar to !include, however it does not accept patterns, only filenames, and will cause check50 to
display an error if that file is missing. The list that is given to files: is processed top to bottom. Later items in
files: win out over earlier items.
The patterns that !include and !exclude accept are globbed, any matching files are added. check50 introduces
one exception for convenience, similarly to how git treats .gitignore: If and only if a pattern does not contain a /, and
starts with a *, it is considered recursive in such a way that *.o will exclude all files in any directory ending with
.o. This special casing is just for convenience. Alternatively you could write **/*.o that is functionally identical to
*.o, or write ./*.o if you only want to exclude files ending with .o from the top-level directory.
Listing 21: .cs50.yaml
1
2
3
4

check50:
checks: true
files:
- !exclude "*.pyc"

Excludes all files ending with .pyc.
Listing 22: .cs50.yaml
1
2
3
4
5

check50:
checks: true
files:
- !exclude "*"
- !include "*.py"

Exclude all files, but include all files ending with .py. Note that order is important here, if you would inverse the two
lines it would read: include all files ending with .py, exclude everything. Effectively excluding everything!
Listing 23: .cs50.yaml
1
2
3
4
5

check50:
checks: true
files:
- !exclude "*"
- !include "source/"

Exclude all files, but include all files in the source directory.

2.8. Configuring check50
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Listing 24: .cs50.yaml
1
2
3
4
5

check50:
checks: true
files:
- !exclude "build/"
- !exclude "docs/"

Include everything, but exclude everything in the build and docs directories.
Listing 25: .cs50.yaml
1
2
3
4
5
6

check50:
checks: true
files:
- !exclude "*"
- !include "source/"
- !exclude "*.pyc"

Exclude everything, include everything from the source directory, but exclude all files ending with .pyc.
Listing 26: .cs50.yaml
1
2
3
4

check50:
checks: true
files:
- !exclude "source/**/*.pyc"

Include everything, but any files ending on .pyc within the source directory. The ** here pattern matches any
directory.
Listing 27: .cs50.yaml
1
2
3
4
5

check50:
checks: true
files:
- !require "foo.py"
- !require "bar.c"

Require that both foo.py and bar.c are present and include them.
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Listing 28: .cs50.yaml
1
2
3
4
5
6
7

check50:
checks: true
files:
- !exclude
- !include
- !require
- !require

"*"
"*.py"
"foo.py"
"bar.c"

Exclude everything, include all files ending with .py and require (and include) both foo.py and bar.c. It is generally
recommended to place any !require``d files at the end of the ``files:, this ensures they are
always included.

2.8.3 dependencies:
dependencies: is a list of pip installable dependencies that check50 will install.
Listing 29: .cs50.yaml
1
2
3
4
5

check50:
checks: true
dependencies:
- pyyaml
- flask

Has check50 install both pyyaml and flask via pip.
Listing 30: .cs50.yaml
1
2
3
4

check50:
checks: true
dependencies:
- git+https://github.com/cs50/submit50#egg=submit50

Has check50 pip install submit50 from GitHub, especially useful for projects that are not hosted on PyPi. See
https://pip.pypa.io/en/stable/reference/pip_install/#vcs-support for more info on installing from a VCS.

2.9 Internationalizing checks
TODO .. todo: write tutorial on internationalizing checks. Extract messages with pygettext.py, compiling translations,
etc.

2.9. Internationalizing checks
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CHAPTER

3

Writing check50 extensions

check50 is a tool for checking student code. As a student you can use check50 to check your CS50 problem sets
or any other Problem sets for which check50 checks exist. check50 allows teachers to automatically grade code on
correctness and to provide automatic feedback while students are coding.

23

CS50 Docs Documentation

24

Chapter 3. Writing check50 extensions

CHAPTER

4

Installation

First make sure you have Python 3.6 or higher installed. You can download Python .
check50 has a dependency on git, please make sure to if git is not already installed.
To install check50 under Linux / OS X:
pip install check50

Under Windows, please . Then install check50 within the subsystem.
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CHAPTER

5

Usage

To use check50 to check a problem, execute check50 like so:
check50 <owner>/<repo>/<branch>/<check>

For instance, if you want to check you call:
check50 cs50/problems/2018/x/caesar

You can choose to run checks locally by passing the --local flag like so:
check50 --local <owner>/<repo>/<branch>/<check>

For an overview of all flags run:
check50 --help
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CHAPTER

6

Checks

In check50 the actual checks are decoupled from the tool. You can find CS50’s set of checks for CS50 problem sets
at . If you would like to develop your own set of checks such that you can use check50 in your own course jump to
Writing check50 checks.
Under the hood, checks are naked Python functions decorated with the @check50.check decorator. check50
exposes several functions, see API docs, that allow you to easily write checks for input/output testing. check50 comes
with three builtin extensions: c, py and flask. These extensions add extra functionality for C, Python and Python’s
Flask framework to check50’s core.
By design check50 is extensible. If you want to add support for other programming languages / frameworks and you
are comfortable with Python please check out Writing check50 extensions.
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CHAPTER

7

cli50

cli50 is a command-line tool via which you can (easily!) mount a directory within a container running cs50/cli,
a Docker image based on Ubuntu 18.04, a popular distribution of Linux. We use cli50 to work on CS50’s own
apps in a standard, contained environment, without having to install apps’ dependencies on our own Macs and PCs. It
provides a command-line environment similar, but not quite identical to, a terminal window on CS50 IDE.

7.1 Installation
1. Install Docker, if you haven’t already.
2. Install Python 3.6 or later, if you haven’t already.
3. Install pip, if you haven’t already.
4. Install cli50 itself:
pip install cli50

7.1.1 Upgrading
pip install --upgrade cli50

7.2 Usage
usage: cli50 [-h] [-f] [-g] [-l [CONTAINER]] [-p [LIST]] [-P] [-s] [-S]
[-t TAG] [-V]
[DIRECTORY]
positional arguments:
(continues on next page)
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(continued from previous page)

DIRECTORY

directory to mount, else $PWD

optional arguments:
-h, --help
show this help message and exit
-f, --fast
skip autoupdate
-g, --git
mount .gitconfig
-l [CONTAINER], --login [CONTAINER]
log into container
-p [LIST], --publish [LIST]
publish port(s) to ports on host
-P, --publish-all
publish exposed ports to random ports on host
-s, --ssh
mount .ssh
-S, --stop
stop any containers
-t TAG, --tag TAG
start cs50/cli:TAG, else cs50/cli:latest
-V, --version
show program's version number and exit

7.3 Examples
7.3.1 Mount current working directory
cli50

Your current working directory will be mounted at ~/workspace within the container.

7.3.2 Mount any directory
Assuming path/to/directory is that directory’s absolute path, you can mount it within the container as follows:
cli50 path/to/directory

The directory will be mounted at ~/workspace within the container.

7.3.3 Skip autoupdate
By default, cli50 autoupdates (i.e., pulls) cs50/cli, the Docker image on which it’s based, which can be timeconsuming on slow internet connections. You can skip autoupdate as follows:
cli50 -f

or
cli50 --fast

7.3.4 Log into running container
If a container (based on any Docker image, cs50/cli or otherwise) is already running, you can spawn a login shell
within it as follows:
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cli50 -l

If multiple containers are running, you’ll be asked, yes or no, in reverse-chronological order, into which container
you’d like to log in.

7.3.5 Mount ~/.gitconfig in container
You can mount your own ~/.gitconfig file within a container (so that you’re not prompted by git-commit for
your name and email address) as follows:
cli50 -g

7.3.6 Mount ~/.ssh in container
You can mount your own ~/.ssh directory within a container (so that you can access your keys) as follows:
cli50 -s

7.4 Source Code
https://github.com/cs50/cli50

7.4. Source Code
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CHAPTER

8

render50

render50 is a command-line tool with which you can generate syntax-highlighted PDFs of source code. In years
past, CS50 generated PDFs of students’ submissions so that teaching fellows (TFs) could annotate the PDFs with
typed feedback. These days, CS50 generates PDFs of lectures’ source code so that students can annotate them during
lectures and so that David has a printout of each lecture’s source code in front of him during lectures!
PDFs can be annotated (for free) with:
• Adobe Reader DC on macOS and Windows
• Evince Document Viewer on Ubuntu Linux
• Preview on macOS

8.1 Installation
1. Install Docker, if you haven’t already.
2. Install Python 3.6 or later, if you haven’t already.
3. Install pip, if you haven’t already.
4. Install render50 itself:
pip install render50

5. Install WeasyPrint’s dependencies.

8.1.1 Upgrading
pip install --upgrade render50
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8.2 Usage
usage: render50 [-h] [-b] [-C] [-i INCLUDE] -o OUTPUT [-r] [-s SIZE]
[-x EXCLUDE] [-y] [-V]
input [input ...]
A command-line tool that renders source code as a PDF.
positional arguments:
input

file or URL to render

optional arguments:
-h, --help
-b, --browser
-C, --no-color
-i INCLUDE, --include

show this help message and exit
render as a browser would
disable syntax highlighting
INCLUDE
pattern to include
-o OUTPUT, --output OUTPUT
file to output
-r, --recursive
recurse into directories
-s SIZE, --size SIZE size of page, per https://developer.mozilla.org/enUS/docs/Web/CSS/@page/size
-x EXCLUDE, --exclude EXCLUDE
pattern to exclude
-y, --side-by-side
render inputs side by side
-V, --version
show program's version number and exit

8.3 Examples
8.3.1 Render a single file
To generate a PDF (e.g., foo.pdf) from a source file (e.g., bar.c), execute:
render50 -o foo.pdf bar.c

8.3.2 Render multiple files
To generate a PDF (e.g., foo.pdf) from multiple source files (e.g., bar.c and baz.c), execute:
render50 -o foo.pdf bar.c baz.c

The source files will be rendered in the order in which they’re specified on the command line.

8.3.3 Include files
To generate a PDF (e.g., foo.pdf) from multiple source files, including only those that match some pattern (e.g.,
*.c), execute:
render50 -i "*.c" -o foo.pdf *

Take care to quote (or escape with \) any patterns with wildcards, lest your shell glob the pattern before render50
can.
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8.3.4 Exclude files
To generate a PDF (e.g., foo.pdf) from multiple source files, excluding those that match some pattern (e.g., *.h),
execute:
render50 -x "*.h" -o foo.pdf *

As before, take care to quote (or escape with \) any patterns with wildcards, lest your shell glob the pattern before
render50 can.

8.3.5 Render two files side by side
To generate a PDF (e.g., foo.pdf) with two source files (e.g., bar.c and baz.c) side by side, execute:
render50 -o foo.pdf -y bar.c baz.c

8.3.6 Render files recursively
To recurse into directories, invoke render50 with -r.

8.3.7 Disable syntax highlighting
To disable syntax highlighting, invoke render50 with -C.

8.3.8 Rendering URLs
To
generate
a
PDF
(e.g.,
foo.pdf)
with
https://github.com/cs50/render50/blob/master/render50), execute:

a

source

file

at

a

URL

(e.g.,

render50 -o foo.pdf https://github.com/cs50/render50/blob/master/render50

Note that URLs on github.com are handled specially: URLs of the form https://github.
com/*/*/blob/* are resolved to https://github.com/*/*/raw/* so that the file is downloaded
from raw.githubusercontent.com.
And URLs of the form https://gist.github.com/*/
(and
https://gist.github.com/
/
#file*
* *
*) are resolved to https://gist.github.com/*/
/raw
(and
https://gist.github.com/
/
/raw/
*
* *
*) so that the file is downloaded from gist.
githubusercontent.com.

8.3.9 Overriding page size
By default, render50 outputs letter-sized (8.5” × 11”) pages in landscape orientation. To override that default,
invoke render50 with --size SIZE, where SIZE is as prescribed by CSS. Supported values for SIZE thus
include:
• letter landscape
• letter portrait
• A4 landscape
• A4 portrait

8.3. Examples
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8.4 Source Code
https://github.com/cs50/render50
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CHAPTER

9

style50

style50 is a command-line tool with which you can check your code for consistency with CS50’s style guide (for
C). If your code isn’t styled consistently, style50 will summarize the changes you should make to your code, as by
highlighting in green characters you should add and highlighting in red characters you should delete.
For instance, consider the code below, wherein the call to printf isn’t properly indented.
#include <stdio.h>
int main(void)
{
printf("hello, world\n");
}

Given that code as input, style50 will output
int main(void) { printf(“hello, world\n”); }
wherein highlighted are four spaces that should be added for style’s sake.
On the other hand, consider the code below, wherein the curly braces are unnecessarily indented.
#include <stdio.h>
int main(void)
{
printf("hello, world\n");
}

Given that code as input, style50 will output
int main(void) { printf(“hello, world\n”); }
wherein highlighted are four spaces that should be deleted for style’s sake.
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9.1 Usage
To check your code’s style, execute
style50 file

where file is the (path to some) file whose style you’d like to check.

9.1.1 Modes
By default, style50 operates in character mode, but you can specify other modes with -o or --output.
Consider the (poorly styled) file below, hello.c, for a look at these modes.
#include <stdio.h>
int main(void)
{
printf("hello, world\n");
}

character
In character mode, style50 compares its input against CS50’s style guide character by character. Were you to
run
style50 --output character hello.c

or just
style50 -o character hello.c

or even just
style50 hello.c

you would see the below.
int main(void) {\n {\n printf(“hello, world\n”); }
split
In split mode, style50 displays its input and output side by side. Were you to run
style50 --output split hello.c

or just
style50 -o split hello.c

you would see the below.
int main(void) int main(void) { { printf(“hello, world\n”); printf(“hello, world\n”); } }
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unified
In unified mode, style50 displays its output line by line, akin to git-diff. Were you to run
style50 --output unified hello.c

or just
style50 -o unified hello.c

you would see the below.
int main(void) - { + { - printf(“hello, world\n”); + printf(“hello, world\n”); - } + }

9.2 Installation
style50 is already installed for you in CS50 IDE, so no need to install it yourself; simply use it as directed!
If you’d like to install style50 on your own Mac or PC, so that you can check your code’s style without using CS50
IDE, you’ll need a command-line environment:
• If running Linux or the like, you already have one! Open a terminal window in your usual way.
• If running Mac OS, you already have one! Open Applications > Utilities > Terminal.
• If running Windows, you’ll need to install the Windows Subsystem for Linux, which is only supported on
Windows 10. Once installed, run bash.
To install style50 within that command-line environment:
1. Install Python 2.7 or higher, if not already installed.
2. Install pip, as via
sudo easy_install pip

if not already installed.
3. Execute
sudo pip install style50

to install style50 itself.
4. Install Artistic Style 3.0. If running a Debian-based operating system (e.g., Ubuntu Linux), simply run
add-apt-repository ppa:cs50/ppa
apt-get update
apt-get install astyle

to install CS50’s own compiled version of astyle.

9.3 Upgrading
Execute

9.2. Installation
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sudo pip install --upgrade style50

to upgrade style50, once installed.

9.4 Source Code
https://github.com/cs50/style50
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CHAPTER

10

submit50

submit50 is a command-line tool with which you can submit work (e.g., problem sets) to a course (e.g., CS50). It’s
based on git, a “distributed version control system” that allows you to save different versions of files without having
to give each version a unique filename (as you might be wont to do on your own Mac or PC!). Via submit50 and, in
turn, git can you thus submit work multiple times (i.e., multiple versions thereof).
When you run submit50, your files are “pushed” (i.e., uploaded) to CS50’s “organization” (also named “submit50”)
on GitHub, a popular service via which developers (like you!) can share code. Your files are stored in a “repository”
(a folder, essentially) to which only you and some of CS50’s staff have access (and anyone else to whom you grant
access). Your work can thus be reviewed and scored in one central place, whether you wrote it in CS50 IDE or
elsewhere!

10.1 Installation
1. Install Python 3.6 or later, if you haven’t already.
2. Install pip, if you haven’t already.
3. Install submit50 itself:
pip install submit50

10.1.1 Upgrading
pip install --upgrade submit50
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10.2 Usage
usage: submit50 [-h] [--logout] [-v] [-V] slug
positional arguments:
slug
prescribed identifier of work to submit
optional arguments:
-h, --help
show this help message and exit
--logout
logout of submit50
-v, --verbose show commands being executed
-V, --version show program's version number and exit

10.3 Examples
10.3.1 Submitting with submit50
To submit work with submit50, cd to the work’s directory and execute
submit50 slug

where slug is the unique identifier for the work you’re submitting, as prescribed by the course (as in a problem’s
specification). Although the slug might resemble the path to a directory, it’s simply a unique identifier, independent
of your own work’s location. If you’ve not recently run submit50 (within the past week), you might be prompted to
log in with your GitHub username and password. (Per the source code for submit50, your username and password
are sent only to GitHub, not to CS50’s own servers.) You will then be prompted to confirm whether you indeed want
to submit one or more files from your current directory, unless you’re missing one or more required files, in which
case submit50 will instead exit without submitting anything.
Via SSH
By default, submit50 pushes your work to GitHub via HTTPS, which requires your GitHub username and password,
which is why submit50 prompts you for both at least once per week. If you’d prefer not to provide submit50
with your GitHub username and password at all, you can instead push your work to GitHub via SSH. Configure your
workspace on CS50 IDE (or your own computer) as follows.
1. Generate an SSH key and add it to ssh-agent.
2. Add the SSH key to your GitHub acount.

3. Execute
ssh git@github.com

to add github.com to the list of known hosts for ssh, answering “yes” if prompted whether you’re sure you
want to continue connecting. If all goes well, you should see the message
Hi <USERNAME>! You've successfully authenticated, but GitHub does not provide
˓→shell access.
Connection to github.com closed.
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(where <USERNAME> is your GitHub username).
Thereafter, you should be able to run submit50 without ever being prompted for your GitHub username or password.

10.3.2 Submitting without submit50
If comfortable with git, you can submit work without submit50. Simply push your work to the expected
branch (i.e., the work’s prescribed slug) of https://github.com/submit50/jharvard (or git@github.
com:submit50/jharvard.git), where jharvard is your own GitHub username. To get started, either clone
that repository or add it to an existing repository as a remote.
On each such branch, take care to create a .gitignore file based on https://github.com/cs50/checks/
raw/master/slug/submit50/exclude, where slug is as before, so that you don’t submit files that
submit50 would otherwise ignore.

10.4 Implementation Details
To see how submit50 uses git underneath the hood, execute
submit50 -v slug

or
submit50 --verbose slug

where slug is the unique identifier for the work you’re submitting.

10.5 FAQs
10.5.1 Do I need to provide submit50 with my GitHub username and password?
Nope, you can instead authenticate via SSH.

10.5.2 If I use git locally, will submit50 affect my local repository?
Nope, submit50 uses its own GIT_DIR (in /tmp). It will ignore any .git directory that you might have locally.

10.5.3 How does submit50 remember my GitHub password?
submit50 remembers your username and password in RAM using git-credential-cache. Your password is
never stored on disk or transmitted elsewhere.

10.6 Source Code
https://github.com/cs50/submit50

10.4. Implementation Details
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CHAPTER

11

cs50/baseimage

cs50/baseimage is a Docker image on Docker Hub on which cs50/cli and cs50/check are based.
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CHAPTER

12

cs50/check

cs50/check is the Docker image on Docker Hub used by submit.cs50.io to run check50.
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CHAPTER

13

cs50/cli

cs50/cli is the Docker image on Docker Hub used by cli50.
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CHAPTER

14

cs50/ide

cs50/ide is the Docker image on Docker Hub used by CS50 IDE.
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CHAPTER

15

cs50/sandbox

cs50/sandbox is a Docker image on Docker Hub with which you can create a container nearly identical to those
used by CS50 Sandbox.
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CHAPTER

16

cs50/server

cs50/server is a Docker image on Docker Hub with which you can (easily!) serve websites with, optionally,
back ends implemented in JavaScript, PHP, Python, or Ruby. (We use it to serve CS50’s own apps on AWS Elastic
Beanstalk!) Essentially, it’s a lightly customized installation of Passenger, an app server, to which we’ve added
support for PHP (for some of CS50’s older web apps). It also facilitates configuration of Nginx, the web server used
by Passenger in in Standalone mode, via two files, httpd.conf and server.conf. The image itself is based on
cs50/cli, which, in turn, is based on cs50/baseimage, which, in turn, is based on Ubuntu 18.04, a popular
distribution of Linux.

16.1 Usage
Assuming you already have Docker installed, base your own Dockerfile on cs50/server as follows, exposing
TCP port 8080, the server’s default:
FROM cs50/server
EXPOSE 8080

Then ensure your app is structured as follows.
• If your app’s back end is implemented in Meteor
– in bundled/packaged mode, ensure you have a file called app.js (your app’s entry point file) in the same
directory as your Dockerfile.
– in non-bundled/packaged mode, ensure you have a file called .meteor in the same directory as your
Dockerfile.
• If your app’s back end is implemented in Node.js, ensure you have a file called app.js (your app’s entry point
file) in the same directory as your Dockerfile.
• If your website’s back end is implemented in PHP, ensure that you have a directory called public in the same
directory as your Dockerfile, inside of which are any PHP files meant to be served publicly.
• If your website’s back end is implemented in Python, ensure you have a (WSGI) file called
passenger_wsgi.py, formatted as prescribed, in the same directory as your Dockerfile.
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• If your website’s back end is implemented in Ruby (or Ruby on Rails), ensure you have a file called config.
ru, formatted as prescribed, in the same directory as your Dockerfile.
• If your website does not have a back end, only a front end implemented in HTML (presumably with CSS and/or
JavaScript), ensure that you have a directory called public in the same directory as your Dockerfile, inside
of which are any HTML (and CSS and/or JavaScript) files meant to be served publicly.

16.2 Configuration
16.2.1 APPLICATION_ENV
If you set an environment called APPLICATION_ENV to a value of dev, as via a docker-compose.yml file,
cs50/server (and, in turn, Passenger) will restart your application’s back end after every HTTP request (by creating
a temporary file called tmp/always_restart.txt), thereby ensuring that any changes you make to files are
noticed (and not cached).

16.2.2 Entry Point
By default, cs50/server looks for a file called app.js, config.ru, .meteor, or passenger_wsgi.py
per its Usage. To configure cs50/server to use some other file as an app’s entry point, adjust your Dockerfile
as follows, where app_type is as prescribed and startup_file is the relative path of the file to use.
FROM cs50/server
EXPOSE ####
...
CMD passenger start --app-type app_type --startup-file startup_file

16.2.3 Nginx
You can customize cs50/server’s installation of Nginx by adding directives as follows.
• To add directives to Nginix’s http context, put them in a file called http.conf in the same directory as your
Dockerfile. Do not surround them with http { and }.
• To add directives to Nginix’s server context, put them in a file called server.conf in the same directory
as your Dockerfile. Do not surround them with server { and }.
rewrite
To redirect, say, /surprise (and /surprise/) to https://youtu.be/dQw4w9WgXcQ, create a file called
server.conf in the same directory as your Dockerfile, the contents of which are as follows.
rewrite ^/surprise/?$ https://youtu.be/dQw4w9WgXcQ redirect;

To redirect one domain to another (e.g., www.cs50.harvard.edu to cs50.harvard.edu), create a file called
server.conf in the same directory as your Dockerfile, the contents of which are as follows.
if ($http_host = www.cs50.harvard.edu) {
rewrite (.*) https://cs50.harvard.edu$1;
}
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try_files
To route all requests (that aren’t for actual files or directories) to public/index.php, create a file called server.
conf in the same directory as your Dockerfile, the contents of which are as follows.
location / {
try_files $uri $uri/ /index.php?$query_string;
}

To route all requests (that aren’t for actual files or directories) to public/index.html (as you might for a
JavaScript-based single-page app), create a file called server.conf in the same directory as your Dockerfile,
the contents of which are as follows.
location / {
try_files $uri $uri/ /index.html;
}

16.2.4 Port
By default, cs50/server uses TCP port 8080. To configure cs50/server to use some other port, adjust your
Dockerfile as follows, where #### is your choice of ports:
FROM cs50/server
EXPOSE ####
...
CMD passenger start --port ####

16.2.5 Static Files
By default, cs50/server assumes that your app’s static files are in public, which is assumed to be in the same
directory as your Dockerfile. To configure cs50/server to look in some other directory, configure your
Dockerfile as follows, where path/to/directory is the relative path to that directory:
FROM cs50/server
...
CMD passenger start --static-files-dir path/to/directory

16.3 Notes
16.3.1 HTTPS
If cs50/server detects that it’s running behind a load balancer, whereby X-Forwarded-Proto (an HTTP
header) is set, and the value of that header is http (the implication of which is that a client’s request used HTTP
instead of HTTPS), cs50/server will redirect the request to use HTTPS.

16.3. Notes
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CS50x FAQs

For answers to other questions, do just strike up a discussion with classmates!

17.1 Can I use CS50 IDE offline?
Yes, if you have particularly slow, expensive, or infrequent Internet access, see CS50 IDE Offline for details on how
you can run your own copy of CS50 IDE locally on your own computer.

17.2 Does CS50x have a test or quiz?
Nope! CS50 at Harvard University and Yale University does have a test and quiz, but CS50x does not.

17.3 Does CS50x have office hours?
No, afraid CS50x is too large, but you can still start a discussion with classmates!

17.4 Does CS50x have sections?
No, afraid CS50x is too large, but you can still start a discussion with classmates!

17.5 What’s the difference between “less comfortable” and “more
comfortable” problems? Do I have to do both?
The “less comfortable” are what you might consider the “standard” version of the problem, designed for students who
have little or no prior experience. The “more comfortable” are the “challenge” version, designed for students who
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consider themselves more comfortable due to prior study/experience before this class. As such, they may require more
concepts than have been covered in the course so far.
You don’t get any extra points for doing the “more comfortable” problems. If you submit both, the one with the highest
grade will count towards your overall pset grade.

17.6 Do I have to choose Verification before starting the course?
Nope! If you would like an edX Verified Certificate, you can pay for verification at any point during the year, even
after completing all of the coursework.

17.7 If I paid for a verified certificate before 2018, do I need to pay
again?
No, you should be able to re-verify yourself via edX’s dashboard.

17.8 If I started CS50x before 2018, can I resume?
Yes, any scores you received on past years’ problem sets will be imported into CS50x 2018. However, moving forward,
you must submit CS50x 2018’s problem sets.

17.9 Is my child too young to take CS50x?
CS50x is perhaps best suited for ages 12 and up. Younger students might need a hand from a parent.

17.10 How to import scores
CS50.me/gradebook?

from

previous

years

into

To import scores from previous years, head to CS50.me/account, and link your edX account under Connected Accounts.

17.11 When are Verified Certificates generated?
At the end of each month, CS50’s staff provides edX with a list of students who have satisfied CS50x’s requirements
(by receiving scores of at least 70% on every required problem submitted as part of the course’s nine problem sets as
well as on the final project). Within a few days, edX then generates students’ Verified Certificates, at which point they
should appear automatically on edX’s dashboard.

17.12 When are deadlines?
CS50x does not have deadlines for problem sets or for the final project. You are welcome to work on and submit at
your own pace.
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17.13 I registered for edX using my Facebook, Google, or Microsoft
account, and can’t log in to submit Problem Set 0. What should
I do?
Unfortunately, edX’s open ID (which we use for authentication) doesn’t support logging in with Facebook, Google,
or Microsoft accounts yet. To get around this, for now, you should try resetting your password (even though you may
have never set any before) from your Account Settings page on edX. Then try the pset0 form again, logging in with
the email associated with your Facebook, Google, or Microsoft account you use to log into edX, and the password you
just set.

17.14 Why is pset0 not graded yet?
If it’s been a while since you submitted Problem Set 0, but you’re still not seeing a grade for it in CS50.me, be sure
you’ve linked your edX account at CS50.me/account!

17.15 Why does edX think my grade 0%?
CS50x doesn’t use edX’s built-in gradebook, so all students’ scores appear (in edX’s gradebook) as 0%. Not to worry,
see CS50.me for your actual scores.

17.13. I registered for edX using my Facebook, Google, or Microsoft account, and can’t log in to 63
submit Problem Set 0. What should I do?
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Docker

CS50 IDE and cli50 (as well as CS50’s web apps) are implemented with containers, “a lightweight, stand-alone,
executable package of a piece of software that includes everything needed to run it: code, runtime, system tools,
system libraries, settings.”
To run containers on your own Mac or PC, you just need to install a container platform like Docker Community Edition
(CE), which is freely available for
• Linux
• macOS
• Windows
and other platforms.
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CS50 Hackathon

The CS50 Hackathon is an epic all-nighter in the HBS Hives atop the i-lab in Batten Hall at 125 Western Avenue
during which you can dive into your final project’s implementation alongside classmates and staff. If you choose to
partake, you’ll be asked to propose three milestones for yourself that evening: a “good” one that you intend to achieve
no matter what; a “better” one that you think you can achieve; and a “best” one that you hope to achieve. Felipe’s will
be served around 9pm; Domino’s will be served around 1am; and those still awake at 5am will be treated to breakfast
at IHOP. Snacks and drinks will be served throughout the evening. Gluten-free and vegetarian options will also be
available.
Space is limited, so attendance is lotteried. If you RSVPed for a spot at this year’s Hackathon, you should
have heard from the CS50 Bot already as to whether you have a spot or were waitlisted. If not, email
heads@cs50.harvard.edu to inquire.
Space at IHOP is even more limited, so attendance at breakfast may be lotteried separately, depending on how
many classmates are still awake at 5am!

19.1 When to get there
19.1.1 Harvard Students
So that check-in isn’t overwhelmed (and you aren’t stuck waiting in line!), do arrive at the HBS Hives per the times
below (unless you’ve been confirmed by the CS50 Bot for late arrival, in which case just arrive asap). If you can’t
make your prescribed time or if you want to travel with your partner(s), that’s fine; just let heads@cs50.harvard.edu
know in advance so we know when to expect you.

19.1.2 Yale Students
So that we arrive in time for Hackathon’s start, please meet outside Arthur K. Watson at 51 Prospect Street by 3:45pm
or 5:15pm (depending on your assigned bus) on Thu 11/30. You will be asked to fill out a brief waiver form before
boarding the charter buses, which are scheduled for prompt 4pm and 5:30pm departures. The 4pm bus (but not the
5:30pm bus) should have outlets and Wi-Fi, though best to charge all gear and download all files ahead of time, just in
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case. In addition, food will not be served until 9pm or so at the Hackathon, so best to order a bag lunch or bring other
snacks with you for the ride. Finally, a reminder that if you take a bus to Harvard with us, you must return to Yale
with us.

19.2 How to get there
19.2.1 Harvard Students
• If walking from, say, Out of Town News, follow this route. Odds are the walk will take 20+ minutes.
• If taking the shuttle, take the Allston Express to the i-lab (which is where the HBS Hives are), per the schedule for the Allston Campus Express PM; consult the column called i Lab Western Ave. Those are regularly
scheduled shuttles, not CS50 Shuttles, so space will be limited. Odds are the trip will take 10+ minutes.
• If driving, drive to 125 Western Avenue in Allston (aka Boston). Metered parking is available behind the i-lab,
in the lot whose entrance is on Western Avenue itself.
If you find yourself lost, call or text the course’s heads at 617-657-CS50 (2750) and tell us what you see around you!

19.2.2 Yale Students
See when to get there.

19.3 What to bring
19.3.1 You must bring. . .
• Harvard ID or Yale ID (unless you don’t have one, in which case bring a printout of the CS50 Bot’s confirmation
of your spot)
• Laptop (that supports Wi-Fi) plus power adapter

19.3.2 You might also want to bring. . .
• Blanket; pillow
• Contact lens case/solution; eyeglasses
• Headphones
• Phone with charger
• Sweater/sweatshirt
• Water bottle

19.3.3 You may not bring. . .
• Alcohol, etc.

68

Chapter 19. CS50 Hackathon

CS50 Docs Documentation

19.4 Slack
To chat with classmates during the Hackathon, visit cs50.ly/slack and join (or create) any channels of interest. If
prompted, enable “desktop notifications.”
• To create a new channel, click to the right of CHANNELS at top-left.
• To message everyone within a channel, start your message with @channel.
• To get someone’s attention in a chat room, type @ and then their name (assuming they’ve logged in too).

19.5 FAQs
19.5.1 Can I attend?
Space is limited, so attendance is lotteried. If you registered for a spot at this year’s Hackathon, you should have heard
from the CS50 Bot as to whether you have a spot! If not, email heads@cs50.harvard.edu to inquire.

19.5.2 Can I arrive late?
Yes, but only if you receive an email from the CS50 Bot or one of the course’s heads confirming a “late arrival” for
you. (Space is limited, so we try to give preference to those who can partake for the entire time.)

19.5.3 Can I leave early?
Harvard Students
If you really, really want to, yes. If you leave before 3am, call the Evening Van Service at 617-495-0400 before 2:30am
to arrange for pick-up. If you leave between 3am and 5am, best to use Lyft or Uber or call 617-782-5500 for a taxi. If
leaving on foot, be sure to walk with multiple friends.
Yale Students
Afraid the buses won’t be leaving until 5am! And if you take a bus from New Haven to Cambridge, you must return
to New Haven on the bus; afraid it’s not allowed to stay behind in Cambridge.

19.5.4 Can I go to IHOP?
Space at IHOP is even more limited than the Hackathon itself, so attendance at breakfast may be lotteried separately,
depending on how many classmates are still awake at 5am!
Please forgive if we can’t accommodate everyone who’d like to go!

19.5.5 How do I check in upon arrival?
First visit the check-in tables in the ground-floor lobby. Then complete your check-in at cs50.ly/checkin.

19.4. Slack
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19.5.6 How do I check out before leaving?
Simply visit cs50.ly/checkout!

19.5.7 What if I can’t attend after all?
If the CS50 Bot confirmed your spot but you can no longer attend, please email heads@cs50.harvard.edu right away
so that we can give your spot to someone who might be waitlisted.

19.5.8 What if my partner was waitlisted but I wasn’t?
Let heads@cs50.harvard.edu know.

19.5.9 When does it end?
By 5am for folks who’re sleepy and by 7am for folks who’re awake (and hungry!) for IHOP, though attendance at
breakfast might be lotteried.

19.5.10 When does it start?
Around 7pm, but do check when to get there.

19.5.11 Will there be food and drinks?
Yes! With so many folks in attendance, though, do try to be gentle with quantities.

19.5.12 Will there be gluten-free food?
Some, yes. It’ll be set aside, so just check with the staff as to where it is.

19.5.13 Will there be shuttles?
Harvard Students
If, because of mobility impairment or medical condition, you find it difficult or impossible to use Harvard’s
shuttles, do contact the Evening Van Service in advance of the Hackathon to make arrangements to and from
the Hackathon. Just let heads@cs50.harvard.edu know if you need assistance.
To the Hackathon?
Yes, via regularly scheduled shuttles. But space will be limited, so it’s probably best to walk to the Hackathon instead
with friends.
With that said, you can take the Allston Express to the i-lab (which is where the HBS Hives are), per the schedule
for the Allston Campus Express PM; consult the column called i Lab Western Ave. Those are regularly scheduled
shuttles, not CS50 Shuttles, so space will be limited. Odds are the trip will take 10+ minutes.

70

Chapter 19. CS50 Hackathon

CS50 Docs Documentation

From the Hackathon?
Yes, via chartered CS50 Shuttles. Some of the shuttles will head to IHOP around 5am, depending on how many
classmates are (still!) hungry, and some shuttles will head to the River houses, Yard, and Quad.
With that said, space will still be limited, even though we’ve literally reserved every shuttle that Harvard owns! So the
shuttles destined for the River houses, Yard, and Quad might make multiple loops, in which case there might be a bit
of a wait. But you’re welcome to walk home with friends if you’d rather not wait!
Please forgive, especially if weary or grumpy at that hour, if we can’t quite fit everyone into shuttles all at once!
Yale Students
To the Hackathon?
Yes, see when to get there.
From the Hackathon?
Yes, via the charter buses on which you arrived. On Fri 12/1 morning, one bus will head straight to New Haven (in
time for Friday-morning classes) and one will stop at IHOP (arriving in New Haven by 10am).

19.5.14 Will there be office hours?
Yes, but one-on-one help will be limited, as a goal of the Hackathon is to remove the last of CS50’s training wheels!
TFs, TAs, and CAs will be present for guidance, but they’ll also be working on projects of their own!
If really in need of help, though, look for staff by the stairs where you checked in!

19.5.15 Will there be gluten-free and vegetarian food?
Yes! There will be gluten-free and vegetarian options from Felipe’s and Domino’s in addition to fruit and veggies.

19.5.16 Will there be Wi-Fi?
Yes. Connect to HBSGUEST or Harvard University. But best to download anything big (e.g., software, movies,
etc.) beforehand, lest Wi-Fi at HBS be a bit slow with so many people on it!

19.5. FAQs
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Heroku

Heroku is a “platform as a service (PaaS) that enables developers to build, run, and operate applications entirely in the
cloud.” Heroku even offers a free plan.
Here’s how to deploy your implementation of, say, C$50 Finance to Heroku from GitHub.
1. Watch Brian’s seminar to learn about git and GitHub, if not already familiar.
2. Sign up for free, private GitHub repositories at https://education.github.com/discount_requests/new, if you
haven’t already.
3. Create a new private repository at https://github.com/new (called, e.g., finance).
4. Take note of the HTTPS URL of the repository (e.g., https://github.com/username/finance.
git, where username is your own GitHub username).
5. Change to your implementation’s directory on CS50 IDE.
cd ~/workspace/pset7/finance/

6. Create a git repo therein.
git init

7. Add the GitHub repository as a “remote,” where username is your own GitHub username.
git remote add origin https://github.com/username/finance.git

8. Push your code to GitHub.
git commit -am "first commit"
git push -u origin master

If you visit https://github.com/username/finance, where username is your own GitHub username, you should see your code in the repository.
9. Sign up for a free Heroku account at https://signup.heroku.com/, if you don’t have one already.
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10. Create a new app at https://dashboard.heroku.com/new-app.
11. Configure your app at https://dashboard.heroku.com/apps/app-name/deploy/github,
where app-name is your Heroku app’s name.
• Add this app to a pipeline: No need to configure; leave as is.
• Deployment method: Select GitHub, then click Connect to GitHub. If prompted to log into GitHub,
click Authorize heroku.
• App connected to GitHub: Search for your app’s repository (e.g., username/finance, where
username is your own GitHub username), then click Connect.
• Automatic deploys: Click Enable Automatic Deploys.
12. Search for and provision Heroku Postgres at https://dashboard.heroku.com/apps/app-name/
resources, where app-name is your Heroku app’s name; select a Plan name of Hobby Dev — Free.
13. At https://dashboard.heroku.com/apps/app-name/resources, where app-name is your
Heroku app’s name, click Heroku Postgres :: Database. In the tab that opens, click Settings, then click
View Credentials. . . . Highlight and copy the URI that appears.
14. In CS50 IDE, open application.py in ~/workspace/pset7/finance/ and find:
db = SQL("sqlite:///finance.db")

Replace sqlite:///finance.db with that URI (so that the CS50 Library will connect to your Postgres
database instead of your SQLite database).
15. In CS50 IDE, execute the below to import finance.db into your Postgres database, where URI is that same
URI. Be sure to append ?sslmode=require to the URI.
pgloader finance.db URI?sslmode=require

Thereafter, if you’d like to browse or edit your Postgres database, you can use Adminer (a tool like phpLiteAdmin for Postgres databases), which is installed on CS50 IDE. To launch Adminer, execute
adminer50

and visit the outputted URL. Log in using your database’s credentials: at https://dashboard.heroku.
com/apps/app-name/resources, where app-name is your Heroku app’s name, click Heroku Postgres
:: Database. In the tab that opens, click Settings, then click View Credentials. . . .
16. Create a new file in CS50 IDE called Procfile in ~/workspace/pset7/finance/ whose contents are:
web: gunicorn application:app

That file will tell Heroku to look in a file called application.py for a variable called app and serve it with
Gunicorn, a production-quality web server. (Flask’s built-in web server is “good enough for testing but probably
not what you want to use in production.”)
17. Add that file to your repository and push it to GitHub.
git add -am "added Procfile"
git push

If you visit https://app-name.herokuapp.com/, where app-name is your Heroku app’s name, you
should see your app! If you instead see some error, visit https://dashboard.heroku.com/apps/
app-name/logs, where app-name is your app’s name, to diagnose! Each time you add (new or changed)
files to your repository and push to GitHub hereafter, your app will be re-deployed to Heroku.
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pip

Most of CS50’s command-line tools are implemented in Python and can be installed on your own Mac or PC via pip,
a command-line tool via which you can install Python packages from PyPI, “the default package index for the Python
community.”
If you already have python installed, odds are you also have have pip. If not, you can install it for
• Linux
• macOS
• Windows
and other platforms.
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python

Most of CS50’s command-line tools require that you have Python 3.6 or higher installed, since CS50 uses f-strings
and assumes that keyword arguments are ordered. (If you already have Python installed on your Mac or PC but didn’t
install it yourself, odds are it’s a version older than 3.6.) You can install the latest version of Python, 3.7, for
• Linux, via pyenv
• macOS, via installer or pyenv
• Windows
and other platforms.
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Terminal

TODO
If you’d like to install render50 on your own Mac or PC, so that you can render PDFs without using CS50 IDE,
you’ll need a command-line environment:
• If running Linux or the like, you already have one! Open a terminal window in your usual way.
• If running Mac OS, you already have one! Open Applications > Utilities > Terminal.
• If running Windows, you’ll need to install the Windows Subsystem for Linux, which is only supported on
Windows 10. Once installed, run bash.
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libcs50 - CS50 library for C

24.1 Installation
24.1.1 Ubuntu
$ curl -s https://packagecloud.io/install/repositories/cs50/repo/script.deb.sh | sudo
˓→bash
$ sudo apt install libcs50

24.1.2 Fedora
$ curl -s https://packagecloud.io/install/repositories/cs50/repo/script.rpm.sh | sudo
˓→bash
$ dnf install libcs50

24.1.3 From Source (Linux and Mac)
1. Download the latest release from https://github.com/cs50/libcs50/releases
2. Extract libcs50-*.*
3. cd libcs50-*
4. sudo make install

24.1.4 Troubleshooting
If when compiling your program, you see:
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/usr/bin/ld: cannot find -lcs50: Add
lib to your .bashrc.

export LIBRARY_PATH=/usr/local/

fatal error: 'cs50.h' file not found: Add
local/include to your .bashrc.

export C_INCLUDE_PATH=/usr/

cannot open shared object file: No such file or directory: Add
LD_LIBRARY_PATH=/usr/local/lib to your .bashrc.

export

24.2 Usage
Note: To use these functions, make sure to include #include <cs50.h> atop your file and compile with the
-lcs50 flag.
string
Type representing a C string. Aliased to char *.
Example usage:
string s = "hello, world!";

void eprintf(const char *format, ...)
Parameters
• format – the printf()-like format string used to display the prompt
• ... – values to be substituted into the format string a la printf()
Prints an error message formatted like printf() to standard error, prefixing it with file and line number from
which the function was called.
Example usage:
int main(void)
{
eprintf("This line of code should be executed\n");
int i;
for (i = 0; i < 50; i++)
{
printf("i is %d\n", i);
}
eprintf("Expected i to be 49 but it is actually %d\n", i);
}

char get_char(const char *format, ...)
Parameters
• format – the printf()-like format string used to display the prompt
• ... – values to be substituted into the format string a la printf()
Returns the char equivalent to the line read from stdin, or CHAR_MAX on error
Prompts user for a line of text from standard input and returns the equivalent char; if text does not represent a
single char, user is reprompted.
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Example usage:
#include <stdio.h>
#include <cs50.h>
int main(void)
{
// attempt to read character from stdin
char c = get_char("Enter char: ");
// ensure character was read successfully
if (c == CHAR_MAX)
{
return 1;
}
char next = get_char("You just entered %c. Enter another char: ", c);
if (next == CHAR_MAX)
{
return 1;
}
printf("The last char you entered was %c\n", next);
}

double get_double(const char *format, ...)
Parameters
• format – the printf()-like format string used to display the prompt
• ... – values to be substituted into the format string a la printf()
Returns the double equivalent to the line read from stdin in [DBL_MIN, DBL_MAX), as precisely
as possible, or DBL_MAX on error
Prompts user for a line of text from standard input and returns the equivalent double; if text does not represent
a double or would cause overflow or underflow, user is reprompted.
Example usage:
double divide_doubles(void)
{
// read double from stdin
double d = get_double("Enter a double: ");
// make sure we read one successfully
if (d == DBL_MAX)
{
return DBL_MAX;
}
double e = get_double("What do you want to divide %lf by? ", d);
// make sure we don't divide by zero
if (e == DBL_MAX || e == 0.0)
{
return DBL_MAX;
}
(continues on next page)

24.2. Usage
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(continued from previous page)

return i / j;
}

int get_int(const char *format, ...)
Parameters
• format – the printf()-like format string used to display the prompt
• ... – values to be substituted into the format string a la printf()
Returns the int equivalent to the line read from stdin in [INT_MIN, INT_MAX) or INT_MAX on
error
Prompts user for a line of text from standard input and returns the equivalent int; if text does not represent an
int or would cause overflow, user is reprompted.
Example usage:
#include <cs50.h>
...
// Returns the sum of two ints read from stdin, or INT_MAX if there was an error.
int add_ints(void)
{
// read int from stdin
int i = get_int("Enter an int: ");
// make sure we read one successfully
if (i == INT_MAX)
{
return INT_MAX;
}
int j = get_int("What do you want to add %d to? ", i);
if (j == INT_MAX)
{
return INT_MAX;
}
return i + j;
}

float get_float(const char *format, ...)
Parameters
• format – the printf()-like format string used to display the prompt
• ... – values to be substituted into the format string a la printf()
Returns the float equivalent to the line read from stdin in [FLT_MIN, FLT_MAX), as precisely
as possible, or FLT_MAX on error
Prompts user for a line of text from standard input and returns the equivalent float; if text does not represent a
float or would cause overflow or underflow, user is reprompted.
Example usage:
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// Returns the product of two floats, or FLT_MAX on error.
float multiply_floats(void)
{
// read float from stdin
float f = get_float("Enter a float: ");
// make sure we read one successfully
if (f == FLT_MAX)
{
return FLT_MAX;
}
float g = get_float("What do you want to multiply %f by? ", f);
if (g == FLT_MAX)
{
return FLT_MAX;
}
return f * g;
}

long get_long(const char *format, ...)
Parameters
• format – the printf()-like format string used to display the prompt
• ... – values to be substituted into the format string a la printf()
Returns the long equivalent to the line read from stdin in [LONG_MIN, LONG_MAX) or
LONG_MAX on error
Prompts user for a line of text from standard input and returns the equivalent long; if text does not represent
an int or would cause overflow, user is reprompted.
Example usage:
#include <cs50.h>
...
// Returns the difference of two longs read from stdin, or LONG_MAX if there was
˓→an error.
long subtract_longs(void)
{
// read long from stdin
long i = get_long("Enter a long: ");
// make sure we read one successfully
if (i == LONG_MAX)
{
return LONG_MAX;
}
long j = get_long("What do you want to subtract from %ld? ", i);
if (j == LONG_MAX)
{
(continues on next page)
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return LONG_MAX;
}
return i - j;
}

char *get_string(const char *format, ...)
param format the printf()-like format string used to display the prompt
param . . . values to be substituted into the format string a la printf()
returns the read line as a string sans line endings, or NULL on EOF.
Prompts user for a line of text from standard input and returns it as a string (char *), sans trailing line ending.
Supports CR (\r), LF (\n), and CRLF (\r\n) as line endings. Stores string on heap, but library’s destructor
frees memory on program’s exit.
Example usage:
int main(void)
{
string s = get_string("Enter string: ");
// ensure string was read
if (s == NULL)
{
return 1;
}
string next = get_string("You just entered %s. Enter a new string: ", s);
if (next == NULL)
{
return 1;
}
printf("Your last string was %s\n", next);
}
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28

Style Guide for C

There’s no one, right way to stylize code. But there are definitely a lot of wrong (or, at least, bad ways). Even so,
CS50 does ask that you adhere to the conventions below so that we can reliably analyze your code’s style. Similarly
do companies typically adopt their own, company-wide conventions for style.

28.1 Line Length
By convention the maximum length of a line of code is 80 characters long in C, with that being historically grounded
in standard-sized monitors on older computer terminals, which could display 24 lines vertically and 80 characters
horizontally. Though modern technology has obsoleted the need to keep lines capped at 80 characters, it is still a
guideline that should be considered a “soft stop,” and a line of 100 characters should really be the longest you write
in C, else readers will generally need to scroll. If you need more than 100 characters, it may be time to rethink either
your variable names or your overall design!
// These next lines of code first prompt the user to give two integer values and then
˓→multiplies those two integer values together so they can be used later in the
˓→program
int first_collected_integer_value_from_user = get_int("Integer please: ");
int second_collected_integer_value_from_user = get_int("Another integer please: ");
int product_of_the_two_integer_values_from_user = first_collected_integer_value_from_
˓→user * second_collected_integer_value_from_user;

In other languages, particularly JavaScript, it is significantly more difficult to constrain lines to a maximum length;
there, your goal should instead be to break up lines (as via \n) in locations that maximize readability and clarity.

28.2 Comments
Comments make code more readable, not only for others (e.g., your TF) but also for you, especially when hours, days,
weeks, months, or years pass between writing and reading your own code. Commenting too little is bad. Commenting
too much is bad. Where’s the sweet spot? Commenting every few lines of code (i.e., interesting blocks) is a decent
guideline. Try to write comments that address one or both of these questions:
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1. What does this block do?
2. Why did I implement this block in this way?
Within functions, use “inline comments” and keep them short (e.g., one line), else it becomes difficult to distinguish
comments from code, even with syntax highlighting. Place the comment above the line(s) to which it applies. No need
to write in full sentences, but do capitalize the comment’s first word (unless it’s the name of a function, variable, or
the like), and do leave one space between the // and your comment’s first character, as in:
// Convert Fahrenheit to Celsius
float c = 5.0 / 9.0 * (f - 32.0);

In other words, don’t do this:
//Convert Fahrenheit to Celsius
float c = 5.0 / 9.0 * (f - 32.0);

Or this:
// convert Fahrenheit to Celsius
float c = 5.0 / 9.0 * (f - 32.0);

Or this:
float c = 5.0 / 9.0 * (f - 32.0); // Convert Fahrenheit to Celsius

Atop your .c and .h files should be a comment that summarize what your program (or that particular file) does, as in:
// Says hello to the world

You may also wish you to include your name, the date, and any other relevant information in your comments atop your
.c and .h files:
// John Harvard
// 1 January 2018
// Problem Set 1

Atop each of your functions (except, perhaps, main), meanwhile, should be a comment that summarize what your
function, as in:
// Returns the square of n
int square(int n)
{
return n * n;
}

28.3 Conditions
Conditions should be styled as follows:
if (x > 0)
{
printf("x is positive\n");
}
else if (x < 0)
(continues on next page)
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{
printf("x is negative\n");
}
else
{
printf("x is zero\n");
}

Notice how:
• the curly braces line up nicely, each on its own line, making perfectly clear what’s inside the branch;
• there’s a single space after each if;
• each call to printf is indented with 4 spaces;
• there are single spaces around the > and around the >; and
• there isn’t any space immediately after each ( or immediately before each ).
To save space, some programmers like to keep the first curly brace on the same line as the condition itself, but we
don’t recommend, as it’s harder to read, so don’t do this:
if (x < 0) {
printf("x is negative\n");
} else if (x < 0) {
printf("x is negative\n");
}

And definitely don’t do this:
if (x < 0)
{
printf("x is negative\n");
}
else
{
printf("x is negative\n");
}

28.4 Switches
Declare a switch as follows:
switch (n)
{
case -1:
printf("n is -1\n");
break;
case 1:
printf("n is 1\n");
break;
default:
printf("n is neither -1 nor 1\n");
(continues on next page)
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break;
}

Notice how:
• each curly brace is on its own line;
• there’s a single space after switch;
• there isn’t any space immediately after each ( or immediately before each );
• the switch’s cases are indented with 4 spaces;
• the cases’ bodies are indented further with 4 spaces; and
• each case (including default) ends with a break.

28.5 Functions
In accordance with C99, be sure to declare main with:
int main(void)
{
}

or, if using the CS50 Library, with:
#include <cs50.h>
int main(int argc, string argv[])
{
}

or with:
int main(int argc, char *argv[])
{
}

or even with:
int main(int argc, char **argv)
{
}

Do not declare main with:
int main()
{
}

or with:
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void main()
{
}

or with:
main()
{
}

As for your own functions, be sure to define them similiarly, with each curly brace on its own line and with the return
type on the same line as the function’s name, just as we’ve done with main.

28.6 Indentation
Indent your code four spaces at a time to make clear which blocks of code are inside of others. If you use your
keyboard’s Tab key to do so, be sure that your text editor’s configured to convert tabs (\t) to four spaces, else your
code may not print or display properly on someone else’s computer, since \t renders differently in different editors.
(If using CS50 IDE, it’s fine to use Tab for indentation, rather than hitting your keyboard’s space bar repeatedly, since
we’ve preconfigured it to convert \t to four spaces.)
Here’s some nicely indented code:
// Print command-line arguments one per line
printf("\n");
for (int i = 0; i < argc; i++)
{
for (int j = 0, n = strlen(argv[i]); j < n; j++)
{
printf("%c\n", argv[i][j]);
}
printf("\n");
}

28.7 Loops
28.7.1 for
Whenever you need temporary variables for iteration, use i, then j, then k, unless more specific names would make
your code more readable:
for (int i = 0; i < LIMIT; i++)
{
for (int j = 0; j < LIMIT; j++)
{
for (int k = 0; k < LIMIT; k++)
{
// Do something
}
(continues on next page)
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}
}

If you need more than three variables for iteration, it might be time to rethink your design!

28.7.2 while
Declare while loops as follows:
while (condition)
{
// Do something
}

Notice how:
• each curly brace is on its own line;
• there’s a single space after while;
• there isn’t any space immediately after the ( or immediately before the ); and
• the loop’s body (a comment in this case) is indented with 4 spaces.

28.7.3 do . . . while
Declare do ... while loops as follows:
do
{
// Do something
}
while (condition);

Notice how:
• each curly brace is on its own line;
• there’s a single space after while;
• there isn’t any space immediately after the ( or immediately before the ); and
• the loop’s body (a comment in this case) is indented with 4 spaces.

28.8 Pointers
When declaring a pointer, write the * next to the variable, as in:
int *p;

Don’t write it next to the type, as in:
int* p;
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28.9 Variables
Because CS50 uses C99, do not define all of your variables at the very top of your functions but, rather, when and
where you actually need them. Moreover, scope your variables as tightly as possible. For instance, if i is only needed
for the sake of a loop, declare i within the loop itself:
for (int i = 0; i < LIMIT; i++)
{
printf("%i\n", i);
}

Though it’s fine to use variables like i, j, and k for iteration, most of your variables should be more specifically named.
If you’re summing some values, for instance, call your variable sum. If your variable’s name warrants two words (e.g.,
is_ready), put an underscore between them, a convention popular in C though less so in other languages.
If declaring multiple variables of the same type at once, it’s fine to declare them together, as in:
int quarters, dimes, nickels, pennies;

Just don’t initialize some but not others, as in:
int quarters, dimes = 0, nickels = 0 , pennies;

Also take care to declare pointers separately from non-pointers, as in:
int *p;
int n;

Don’t declare pointers on the same line as non-pointers, as in:
int *p, n;

28.10 Structures
Declare a struct as a type as follows, with each curly brace on its own line and members indented therein, with the
type’s name also on its own line:
typedef struct
{
string name;
string dorm;
}
student;

If the struct contains as a member a pointer to another such struct, declare the struct as having a name
identical to the type, without using underscores:
typedef struct node
{
int n;
struct node *next;
}
node;

28.9. Variables
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CS50 Forms

CS50 Forms is a web app at forms.cs50.io that allows you to:
• add authentication to Google Forms, requiring that respondents authenticate via edX, HarvardKey, or Yale
NetID, thereby allowing you to post a form’s URL online while still restricting access
• pre-fill Google Forms with a respondent’s name and email address as well as a respondent’s edX username,
HUID, or NetID, thereby decreasing the probability of typographical errors
Upon authenticating, a respondent will be redirected to a “pre-filled link” like
https://docs.google.com/forms/d/e/1FAIpQLSeaFUWMKeKJo5225POeCeJXHktJecyStal_
˓→sn6nYEb0rOEgYw/viewform?entry.1142694446=username%40example.com&entry.
˓→164044587=Full+Name

wherein username%40example.com (i.e., username@example.com) represents the respondent’s email address and Full Name represents the respondent’s full name, values that Google will use to pre-fill the form.

29.1 Notes
• Respondents can still override (i.e., manually change) any pre-filled value. In our experience, respodnents tend
not to, unless explicitly asked to, e.g., adjust their full name to reflect a preferred nickname.
• After authenticating, a respondent could theoretically share a form’s URL, pre-filled or otherwise, with anyone on the internet (as via email or any other mechanism), thereby allowing others to access the form without
authentication. In our experience, respondents tend not to, if only because there isn’t much demand for unauthenticated access to the forms in question, which are usually assignments! CS50 Forms simply raises a bar
thereto.
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CS50 IDE

30.1 CS50 IDE FAQs
30.1.1 How can I open a file in the editor from a terminal tab?
If you want to open a file named foo, run c9 open path/to/foo.

30.1.2 I closed the terminal underneath my editor by mistake. How do I get it back?
If the Console pane at the bottom is visible, you should be able to open a new terminal tab by clicking the
atop that pane, and choosing New Terminal.

button
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TIP: If you no longer see the Console pane, you can bring it back via View > Console or by hitting F6. You can also
open a terminal in any other pane.

30.1.3 Can I use a different editor?
Sure, if you are more familiar, you can run editors in the terminal such as emacs, nano, or vim.

30.1.4 What’s the best way to back up my work?
Choose File > Download Project to download ide50.zip, an archived file (in .zip format) of your workspace
files.

30.1.5 How to restore my work after backing it up?
If you backed up your work per What’s the best way to back up my work?, and you would like to restore it in a different
(or same) workspace, upload ide50.zip to your workspace per Uploading Files, then run the following commands
in a terminal tab in your workspace:
$ unzip ide50.zip
$ mv ~/workspace/workspace/* ~/workspace/
$ rm -rf ide50.zip ~/workspace/workspace/

30.1.6 What if I already have a Cloud9 account?
You can use your existing Cloud9 account to create a CS50 IDE workspace by clicking this link, which will bring up
a Create a workspace page with the default settings already selected.
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NOTE: Be sure to check Private, under Hosted Workspace, if not checked.
All you’ll need to do is create it! You can then access CS50 IDE from your Cloud9 dashboard, like you would access
any other workspace.

30.1.7 I see a .c9 folder appearing right under my ~/workspace folder, that I
haven’t created. Is this normal?

Yes, this is totally normal. If curious, ~/workspace/.c9/ is used by Cloud9 IDE (and CS50 IDE) to hold some
workspace settings, your undo history, and other metadata.
Generally, you shouldn’t touch this folder or its contents. Files and folders whose names start with a dot (aka dot files)
should be hidden by default. You may want to hide the .c9 folder (along with any other dot files) by clicking the gear
icon atop the file browser on the left and unchecking Show Hidden Files.

30.1. CS50 IDE FAQs
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30.1.8 What if my workspace runs out of disk space?
Old workspaces used to have less than 5GB of total disk space. This may be problematic particularly when running
update50 to get the latest updates since this may consume your disk space quota. We are hoping to address this
better in the near future so that wouldn’t be a concern for you, but in the meantime you can get a 5GB workspace by
following these instructions:
1. Back up your files per What’s the best way to back up my work?.
2. From CS50 IDE > Dashboard click on ide50.

icon next to
on the top-right corner. Alternatively, you may visit
3. Click on the
https://cs50.io/<your-username>/ide50/settings where <your-username> is your CS50 IDE username. Your
CS50 IDE username should be part of the URL of your workspace, or you may run username50 in a CS50
IDE terminal tab to get it.
4. If you are sure you have backed up your files, scroll down to the bottom of the page and click Delete workspace.
5. In the text field type ide50 and click Confirm.
6. Go to cs50.io and log in as usual.

This should automatically create a new 5GB workspace for you. You can confirm by clicking
on the top-right corner and checking the disk space. Please follow the instructions per How to restore my work after
backing it up? to upload your files to your new workspace. Let sysadmins@cs50.harvard.edu know if you need further
assistance!

30.1.9 I’m getting an error that says Looks like check50 (or submit50)
isn't enabled for your account yet. Log into https://cs50.
me/ in a browser, click Authorize Application, and re-run
check50 (or submit50) here! even after following these instructions.
What should I do?
Go
to
https://github.com/check50/<your-username>/invitations
and
https://github.com/submit50/<yourusername>/invitations, after replacing <your-username> with your actual GitHub username, and click
Accept invitation, then try check50 and/or submit50 again. Let sysadmins@cs50.harvard.edu know if you need
further assistance!
If curious why this happens, earlier the Authorize Application step was sufficient for adding your GitHub user as
a collaborator with write access on your check50 and submit50 repositories that we automatically create for you,
but GitHub updated their API recently to require users to accept invitations for repositories they’re added to, so the
Authorize Application step isn’t sufficient any more, and you have to accept these invitations.

30.1.10 My workspace doesn’t look like David’s from lecture and none of the *50
commands work. What should I do?
Probably you’re using a non-CS50 workspace. Follow these instructions to delete your current workspace, and create
a CS50 workspace:
1. Back up your files per What’s the best way to back up my work?.
2. From Cloud9 > Go To Your Dashboard click on ide50.
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3. Click on the
icon next to
on the top-right corner. Alternatively, you may visit
https://cs50.io/<your-username>/ide50/settings where <your-username> is your CS50 IDE username. Your
CS50 IDE username should be part of the URL.
4. If you are sure you have backed up your files, scroll down to the bottom of the page and click Delete workspace.
5. In the text field type ide50 and click Confirm.
6. Go to cs50.io and log in as usual.
7. If you’re presented with the Create a new workspace page, be sure to click Private under Hosted workspace,
and to select Harvard’s CS50 under Choose a template.
8. Follow the instructions per How to restore my work after backing it up? to upload your files to your new
workspace. Let sysadmins@cs50.harvard.edu know if you need further assistance!

30.1.11 How to restore files that I have accidentally deleted?
Please follow the instructions at How do I recover a deleted file?. Let sysadmins@cs50.harvard.edu know if you
need further assistance!

30.2 CS50 IDE Offline
Normally, CS50 IDE requires a constant connection to the internet. This may not fit users with slow or unstable
internet connections, or those who want to continue using the IDE offline for any number of reasons. The following
instructions walk you through how to download and install the offline version of CS50 IDE.

30.2.1 Installing
CS50 IDE Offline is a containerized app. We need to install a platform called Docker to run it.
Linux
Follow the instructions for your Linux distribution to install Docker Engine.
1. Open up a terminal window and run the following command to create a new CS50 IDE instance:
docker run --privileged -e "IP=127.0.0.1" -e "PORT=8080" --name ide50 -d -p
˓→5050:5050 -p 8080-8082:8080-8082 cs50/ide

2. Visit http://localhost:5050/ in your favorite browser to access CS50 IDE.
Mac
NOTE: If these system requirements are not met, skip to Docker Toolbox.
1. Install Docker for Mac.
2. Open up a terminal window and run the following command to create a new CS50 IDE instance:

30.2. CS50 IDE Offline
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docker run --privileged -e "IP=127.0.0.1" -e "PORT=8080" --name ide50 -d -p
˓→5050:5050 -p 8080-8082:8080-8082 cs50/ide

3. Visit http://localhost:5050/ in your favorite browser to access CS50 IDE.
Windows
NOTE: If these system requirements are not met, skip to Docker Toolbox.
1. Install Docker for Windows.
2. Open up a command prompt window and run the following command to create a new CS50 IDE instance:
docker run --privileged -e "IP=127.0.0.1" -e "PORT=8080" --name ide50 -d -p
˓→5050:5050 -p 8080-8082:8080-8082 cs50/ide

3. Visit http://localhost:5050/ in your favorite browser to access CS50 IDE.
Docker Toolbox
NOTE: You should only follow these instructions if you are a Windows or Mac user and the system requirements for
Windows or Mac, respectively, are not met.
1. Download and install Docker Toolbox for Windows or Mac.
2. Open up the Docker QuickStart Terminal app that was installed on your computer.
After a while, you should see something like the following, with a command prompt below it:

3. The IP stated in the screenshot above is the IP of the Docker machine. It may be different on your computer.
You are going to use this IP to access your CS50 IDE, so you should record it.
4. Run the following command in the Docker QuickStart Terminal to create a new CS50 IDE instance:
docker run --privileged -e "IP=$(docker-machine ip default)" -e "PORT=8080" -˓→name ide50 -d -p 5050:5050 -p 8080-8082:8080-8082 cs50/ide

5. Visit <http://<machine-ip>:5050/>, in your favorite browser, to access CS50 IDE, after replacing
<machine-ip> with the actual IP for the Docker machine.
TIP: If you ever forgot or lost the IP of the Docker machine, you should be able to get it back by running
docker-machine ip default in the Docker QuickStart Terminal.
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30.2.2 Managing the IDE
Starting the IDE
If you can’t access your CS50 IDE (e.g., after restarting your computer), it’s possibly because it’s stopped. To start it
back, open up a terminal window (if using Mac), a command prompt (if using <>), or Docker QuickStart Terminal (if
using Docker Toolbox, and run the following command:
docker start ide50

Restarting
Normally, you shouldn’t need to restart the IDE, but if you ever wanted to open up a terminal window (if using Mac), a
command prompt (if using Windows) or Docker QuickStart Terminal (if using Docker Toolbox), and run the following
command:
docker restart ide50

Stopping
To stop CS50 IDE, open up a terminal window (if using Mac), a command prompt (if using Windows) or Docker
QuickStart Terminal (if using Docker Toolbox), and run the following command:
docker stop ide50

Removing
To remove your CS50 IDE instance, open up a terminal window (if using Mac), a command prompt (if using Windows)
or Docker QuickStart Terminal (if using Docker Toolbox), and run the following command:
docker rm ide50

30.2.3 Where to Go Next?
Read up on on how to use CS50 IDE itself!

30.3 CS50 IDE
30.3.1 Introduction
CS50 IDE is a cloud-based Integrated Development Environment powered by Cloud9 that features a cloud-based
Ubuntu environment. It features a browser-based editor, that supports C syntax highlighting and word completion, a
GUI-based GDB debugging, full control over a cloud-based Ubuntu environment, and many more features including
themes, customizable layouts, and keyboard shortcuts. Since it’s cloud-based, you can continue working on your
problem sets even if you use a different computer!

30.3. CS50 IDE
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30.3.2 Getting Started
1. Visit cs50.io.
2. Use your edX, Harvard, or Yale credentials to log in.
3. Once you log in, you will automatically be forwarded to CS50 IDE! Hereafter, you may simply return to cs50.io
to log in and return to CS50 IDE, where all your files and settings are preserved.
4. Ensure your workspace is up-to-date. (See Updating!)
NOTE: Upon logging into CS50 IDE for the first time, you may be prompted (again) for your email address. If so,
after providing it, click Private under Hosted workspace, then click Create workspace.

30.3.3 Working with Files
Creating Files
There are multiple ways to create a new file in CS50 IDE:
• Click File > New File.
• Click on the little
particular pane.

button atop any of the open panes and choose New File to open a blank file in that

• From the file browser on the left, right-click or control-click on a directory and choose New File from the menu
to create a blank file inside that directory, then double-click that file to open it.
• Press Alt + N (on a PC) or + N (on a Mac).
TIP: There are also provided file templates. For example, to open a .c template, click File > New From Template >
C and save yourself some keystrokes!
Saving Files
When a file is open in a tab and you have some unsaved changes, CS50 IDE will show a red dot a top that tab, until
you save your changes. Probably the easiest way to save a file is to press Ctrl + S (on a PC) or + S (on a Mac), but
you can also achieve the same by clicking File > Save (or File > Save As. . . if you want to save that as a new file),
while you’re working on that file.
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Downloading Files
To download a file from your workspace to your local computer, simply navigate to the location of that file, in the file
browser on the left, right-click on that file’s name, and choose Download.
To download all files in your workspace, click File > Download Project.
Uploading Files
To upload a file from your local computer to your workspace:
1. Select a directory where you want your files to get uploaded into, by clicking on that directory in the file browser
on the left. By default, this is going to be your ~/workspace directory.
2. Click File > Upload Local Files. . . , then choose either Select files or Select folder, depending on what you
want to upload.
File Revision History
While working on a file, you can easily undo changes by clicking Edit > Undo or by hitting Ctrl + Z (on a PC) or +
Z on your keyboard. Similarly, you can redo changes by clicking Edit > Redo or by hitting Ctrl + Shift + Z.
The CS50 IDE also keeps track of file revisions, in case you want to toggle between file revisions, without having
to undo or redo many times. You can show the whole file revision history by clicking File > Show File Revision
History, which will show a timeline similar to the following, on which you can click to jump to a particular version.

30.3.4 Working with Terminals
Terminals allow you to interact with the underlying Ubuntu environment of CS50 IDE, using textual commands, to do
all sorts of things, such as creating, copying, or moving files, compiling and running your programs, and more.
Opening New Terminals
When CS50 IDE first starts, there should be a terminal tab open at the bottom, by default. You can also open a new
terminal tab in that or any other pane of your choice by clicking the
button atop that pane, and choosing New
Terminal. Alternatively, you may just hit Alt + T (on a PC) or Option + T (on a Mac).
By default, the current working directory (CWD) in a new terminal is your ~/workspace directory. You can always
navigate to your desired directory using cd path/to/directory.
TIP: To open a terminal in a different directory, navigate to that directory in your file browser, right-click (on a PC) or
Ctrl-click (on a Mac) on the directory’s name, and choose Open Terminal Here.
Copying and Pasting
You will probably need to copy and paste commands into terminal tabs to run them. By default, copying and pasting
via menus will work inside CS50 IDE only (you might even get warned), so it’s recommended to use your keyboard
to copy and paste by hitting Ctrl + C and Ctrl + C> (on a PC) or + C and + V (on a Mac).
30.3. CS50 IDE
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Command History
You will be often using the same commands over and over. Whether you don’t remember a particular command, or
too lazy to type it again, you can leverage the command history that is kept by your terminals. You can scroll up and
down through the list of commands by hitting your keyboard’s up or down arrow.
Additionally, you can search for a particular command by hitting Ctrl + R (on a PC) or + R (on a Mac), then hitting
the same again to scroll through the matches, then hitting Tab to select a particular match to modify it before running
or Enter if you want to run it directly.
Clearing Terminals
From time to time you will need to clear your terminal so that it’s easier to see what you’re doing. There are two main
ways to do that
1. Press Ctrl + L (on a PC) or + L (on a Mac). This way doesn’t actually clear the terminal, but rather just scrolls
down, so you can always scroll back up and see what got cleared, if you wanted to.
2. Press Ctrl + K (on a PC) or + K (on a Mac). This way actually clears the terminal; you won’t be able to scroll
back up and see what got cleared.
Restarting Terminals
Sometimes you need to restart your terminals, for example after an update (see <<updating-ide>>), to have the new
changes reflected on your terminal tabs. While you could go ahead and close any open terminal tabs, then reopen
them, there’s an easier way by right-clicking (on a PC) or Control-clicking (on a Mac) inside of any terminal tab and
choosing Restart All Terminal Sessions.
Troubleshooting
If you want to force a program to quit, for example because it’s stuck in an infinite loop, press Ctrl + C (on a PC) or +
C (on a Mac). It may take several seconds for the program to respond, so do be patient!
As a last resort, in case the program won’t stop, you might need to forcibly kill it. Perhaps the easiest way to do that
is to just close the terminal tab, clicking Close when prompted, and opening a new one.
Alternatively, you can click the stats button (showing memory, CPU, and disk stats) on the upper-right corner, and
click Show Process List, find your program in the list, select it, and click Kill. If it doesn’t respond within a few
seconds, click Force Kill instead.

30.3.5 Layouts and Themes
Layouts
The CS50 IDE is very customizable when it comes to laying out panes and tabs. You could very easily split a pane
horizontally or vertically, by right-clicking (on a PC) or Ctrl-clicking (on a Mac) somewhere next to the
atop the pane you want to split and choosing Split Pane in Two Rows or Split Pane in Two Columns.
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You could also move tabs between different panes by dragging and dropping a tab to the targeted pane or even to
somewhere you want a new pane with that tab to be created.
Themes
There’s a number of themes available in CS50 IDE that you can find under View > Themes. By default a theme called
Cloud9 Day is selected, but if you prefer a dark theme, you can select it via View > Night Mode. Otherwise, you’re
free to select from any of the available themes.
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Presentation Mode
CS50 IDE also provides Presentation Mode in which the user interface is even more simplified and font sizes are
larger. You can toggle that mode via View > Presentation Mode.

30.3.6 Sharing Your Workspace
Adding Users to Your Workspace
Sometimes it’s useful to share your workspace with someone (e.g. your teacher or TF) to assist you with something. If
using the online IDE, and you have the username or email of the user with whom you want to share your workspace,
use the Share button near the upper-right corner, type that username or email in the text field under Invite People and
click Invite.
Removing Users from Your Workspace
To remove a user from your workspace, click on the Share button near the upper-right corner, then click on the
button next to the name of that user, in the Who has access section, and confirm by clicking Remove member when
prompted.
Sharing Your Workspace Domain
By default, your workspace domain is private. But you may want your workspace domain to be publicly accessibly,
for example, if you want to demonstrate a web app hosted in your workspace to your teacher, TF, fellow students,
friends, or even people on the internet. To do that, click the Share button on the upper-right corner, and check the box
that says Public, in front of Application.
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TIP: The URL next to Application is your workspace’s fully-qualified domain name, but you can also print it by
running hostname50 or open it in a new browser tab by clicking CS50 IDE > Web Server.

30.3.7 Updating the IDE
To ensure your workspace is up-to-date, click inside any open terminal tab (or open a new one), type update50 and
hit Enter.

30.3.8 Reporting Problems
If having any problems with CS50 IDE, please contact sysadmins@cs50.harvard.edu with all the necessary information about the problem, and how to replicate it, attaching screenshot(s) if need be!
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CS50 Lab

CS50 is a programming environment at lab.cs50.io for scaffolding that enables
• teachers to create step-by-step programming lessons (i.e., labs), providing incremental feedback at each step,
and
• students to progress from an empty file (or starter code) to working code, with hints and feedback along the way.
To create a lab as a teacher, all you need is a GitHub account and a (public or private) repository. To log into and work
on a lab as a student, all you need is the former. Neither use case requires familiarity with git itself though if or once
comfortable with git, you can create labs even more quickly via a command line!
CS50 Lab is essentially an extension of CS50 Sandbox that allows teachers to embed interactive instructions alongside
a sandbox. As such, CS50 Lab is, also, essentially a lightweight version of CS50 IDE with problems’ specifications
embedded in students’ actual programming environments.
URLs of labs are of the form https://lab.cs50.io/:owner/:repo/:branch/:path, where
• :owner is the lab’s owner, a GitHub user or organization, on github.com,
• :repo is that owner’s repository in which the lab’s source can be found,
• :branch is the branch on which the lab’s source can be found in that repository, and
• :path is the path to the lab’s source on that branch.
The source for a lab like https://lab.cs50.io/cs50/labs/python/mario/ can thus be found in https://github.com/cs50/labs/
tree/python/loops/, wherein
• cs50 is the lab’s owner (hey, that’s us),
• labs is the lab’s repository,
• python is the lab’s branch,
• loops is the lab’s path, and heretofore unmentioned,
• tree is just a GitHub-specific trick, sandwiched between :repo and :branch, via which you can browse
that branch and path.
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31.1 Creation
To create a lab:
1. Sign up for a (free) GitHub account, if you don’t have one already.
2. Create a repository, if you don’t have one (that you’d like to use) already.
3. Create a file in that repository called .cs50.yaml, optionally inside of one or more directories, using GitHub’s
website. Or create (and push) the same using git itself. Configure .cs50.yaml per below.
4. Optionally create another file in the same directory as .cs50.yaml called README.md, configured per below.
While technically optional, without this file your lab won’t have instructions!
5. Optionally create in or upload to that directory (or any descendent thereof) any files you’d like to install in a
student’s environment (and automatically open in the text editor’s tabs).
You can then (assuming no mistakes!) visit https://lab.cs50.io/:owner/:repo/:branch/:path,
where each of those placeholders is as above, to see your lab!

31.2 Configuration
31.2.1 .cs50.yaml
To define a lab, it suffices to create a file called .cs50.yaml in the root (or subdirectory) of a branch in a repository
that contains, minimally, a top-level lab50 key, the value of which is true:
lab50: true

windows
It turns out the above is an abbreviation of (and equivalent to)
lab50:
windows:
- editor
- readme
- terminal

wherein
• editor signifies that the lab should have an embedded text editor,
• readme signifies that the lab has instructions (written in README.md), and
• terminal signifies that the lab should have an embedded terminal window.
Also available as values for windows are
• browser, which signifies that the lab should have an embedded browser, and
• x11, which signifies that the lab should have an embedded X window,
but those two values are mutually exclusive.
A lab must have, as the value of windows, at least one of these five values.
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It’s worth noting that a lab without readme is functionally similar to CS50 Sandbox. Whereas sandboxes are temporary, cookie-based and thus lost when cookies are cleared or expired, labs are persistent: if a student logs into a lab
and makes changes, those changes will persist indefinitely (unless the student resets the lab).
files
To install files in students’ environments (e.g., foo.c and foo.h), add a key below lab50 called files (as a
sibling of windows, if explicitly present):
lab50:
files:
- foo.c
- foo.h

If those files exist (in the same directory as .cs50.yaml), they will be copied into students’ environments and
opened automatically (if recognized as text files). If those files don’t exist, they will be created as empty (and opened).
Files (e.g., bar.c and bar.h) can also be in subdirectories (of whatever directory .cs50.yaml is in):
lab50:
files:
- foo/bar.c
- foo/bar.h

Alternatively, you can specify subdirectories:
lab50:
files:
- foo/

Globbing is also supported, but asterisks have special meaning in YAML, so take care to quote any strings that have
wildcards:
lab50:
files:
- "foo/*.c"
- "foo/*.h"

checks
To specify checks via which students can receive feedback from check50 on their lab, add a key below lab50 called
checks, the value of which is those checks’ slug:
lab50:
checks: cs50/labs/python/mario

That slug can defined in the same .cs50.yaml file in which the lab itself is defined, as with:
check50: true

submit
To specify a “slug” via which students can submit a lab via submit50, add a key below lab50 called submit, the
value of which is that slug:
31.2. Configuration
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lab50:
submit: cs50/labs/python/mario

That slug can defined in the same .cs50.yaml file in which the lab itself is defined, as with:
submit50: true

31.2.2 README.md
A lab’s instructions should be written in README.md (which must be in the same directory as .cs50.yaml), using
GitHub-flavored Markdown. Via CS50-specific “tags” can you add interactive features to those instructions. If present,
each should appear on a line of its own but might very work in other contexts too (e.g., in ordered or unordered lists).
Your Markdown can also contain, if need, raw HTML, but not these tags.
Your Markdown can also contain emoji.
check
To provide students with a Check button via which they can receive automated feedback on a particular check
from check50, using the slug defined in .cs50.yaml, you can use these tags, between which is an object (e.g.,
compiles) that representing that check’s result (and the results of any checks on which that check depends):
{% check %}
{{ compiles }}
{% endcheck %}

You can override the button’s label with a quoted string:
{% check "Does your code compile?" %}
{{ compiles }}
{% endcheck %}

Between those tags can also be logic that inspects the value of objects’ properties (e.g., passed):
{% check "Does your code compile?" %}
{{ if compiles.passed }}
Yes! Nicely done.
{% else %}
{{ compiles }}
{% endif %}
{% endcheck %}

Supported logic includes control flow and iteration.
next
To paginate a lab’s instructions, inserting a Next button and hiding, until clicked, everything below it, you can use this
tag:
{% next %}

You can override the button’s label with a quoted string:
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{% next "Step 2" %}

spoiler
To provide students with a spoiler, code or information they should only by clicking a Spoiler button, you can use
these tags:
{% spoiler %}
The Answer to the Great Question...
Of Life, the Universe and Everything...
Is...
Forty-two.
{% endspoiler %}

You can override the button’s label with a quoted string. Accordingly, via
{% spoiler "Hint" %}
You're really not going to like it.
{% endspoiler %}

could you provide students with a hint. And via
{% spoiler "Solution" %}
Forty-two.
{% endspoiler %}

could you provide students with a solution.
submit
To display, via a Submit button, the command via which students can submit a lab via submit50, you can use this
tag, provided your .cs50.yaml has a value beneath lab50 for submit:
{% submit %}

You can override the button’s label with a quoted string:
{% submit "Ready to submit?" %}

video
To embed a YouTube video (responsively) in a lab’s instructions, you can use this tag, wherein the URL can be any
URL of a video on YouTube:
{% video https://www.youtube.com/watch?v=oHg5SJYRHA0 %}

31.3 Acknowledgements
Special thanks to CS50’s friends at Next XYZ and Google for their support of this app!
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CS50 Sandbox

CS50 Sandbox is a web app at sandbox.cs50.io, for students and teachers especially, that allows users to
• create temporary programming environments (sandboxes) quickly, without even logging in, and
• share copies (aka clones) of those sandboxes with others.
For instance, a teacher might
• begin a class by asking students to visit sandbox.cs50.io and start a sandbox for C with a terminal window and
text editor, with a file called hello.c, all of which the app’s landing page facilitates,
• provide students with a pre-configured link like https://sandbox.cs50.io/?file=hello.
c&window=editor&window=terminal (perhaps shortened via a URL shortener) that, when visited,
would yield the same, or
• provide students with starter code, as by creating a sandbox, editing one or more files, and asking students to
clone that sandbox by visiting its unique URL.
CS50 Sandbox is essentially a lightweight version of CS50 IDE, CS50’s web-based integrated development environment. CS50 Sandbox is quicker to start, since it doesn’t require authentication, but CS50 Sandbox
• does not offer persistence, insofar as sandboxes are cookie-based and thus lost when cookies are cleared or
expired,
• does not have debug50, CS50 IDE’s graphical debugger for C and Python,
• does not offer file revision history, and
• does not support real-time collaboration or chat.

32.1 Configuration
CS50 Sandbox supports, via both GET and POST, these HTTP parameters:
• file, which, if present, is a file path to pre-create within the sandbox in /root/sandbox. If window has
a value of editor (potentially among other values), that file will also be pre-opened in the code editor, unless
the value of file includes not only a file name but a parent directory as well.
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• window, whose value must be at least one of:
– browser, in which case the sandbox will have an embedded browser, pre-configured with an address of
http://localhost:8080/,
– editor, in which case the sandbox will have a code editor,
– terminal, in which case the sandbox will have a terminal window, and/or
– x11, in which case the sandbox will have an embedded X window.
Values of browser and x11 for window are mutually exclusive.
When submitted via POST, each value of file can be an actual file encoded as multipart/form-data, as via a
form like the below:
<form action="https://sandbox.cs50.io/" enctype="multipart/form-data" method="post">
<input name="file" type="file">
<input name="window" type="hidden" value="editor">
<input name="window" type="hidden" value="terminal">
<input type="submit">
</form>

32.2 Notes
• If a user accidentally closes a sandbox and does not recall its unique URL, it can be restarted via a link at the
bottom of sandbox.cs50.io.
• The languages and frameworks atop sandbox.cs50.io not mutually exclusive. The radio buttons only serve to
pre-check checkboxes (corresponding to UI features) appropriate for those languages and frameworks. Any
language or framework can be used thereafter in any sandbox.

32.3 Related
32.4 Acknowledgements
Special thanks to CS50’s friends at Next XYZ and Google for their support of this app!
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CS50 Vault

CS50 Vault is a web app at vault.cs50.io that allows you to add authentication to any link, requiring that users authenticate via edX, HarvardKey, or Yale NetID in order to access it, thereby allowing you to post a link online while still
restricting access.
Upon authenticating, a user will be redirected to the link, unless the link can be rendered in an iframe, in which case
its URL will be masked. Alternatively, if the link is to a:
• file on dropbox.com, the link can be customized to trigger an automatic download of the file
• folder on dropbox.com, the link can be customized to trigger an automatic download of a ZIP of the folder
• video on youtube.com (or youtu.be), the link can be customized to embed the video in an iframe such that it
fills the user’s window and autoplays

33.1 Notes
• After authenticating, a user could theoretically share a link with anyone on the internet (as via email or any other
mechanism), thereby allowing others to access it without authentication. However, once accessed by one user,
most any digital asset can be shared with (or copied for) others. CS50 Vault simply raises a bar thereto.
• Embedding a YouTube video in an iframe obfuscates, but does not prevent discovery of, the video’s underlying
URL, which is exposed via HTML. After authenticating, a user could theoretically share that link as well.
• A link will only be rendered in an iframe if it
– is not served with an X-Frame-Options header,
– is not served with an Content-Security-Policy header, the value of which contains
frame-ancestors, and
– is served with a Content-Type header, the value of which is application/pdf or text/html.
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